
   

Intel® Server Board SCB2 
Product Guide 

 

A Guide for Technically Qualified Assemblers of Intel® Identified 
Subassemblies/Products 

 

Order Number:  A55880-003 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Disclaimer 

Information in this document is provided in connection with Intel products.  No license, express or implied, by estoppel or 
otherwise, to any intellectual property rights is granted by this document.  Except as provided in Intel’s Terms and Conditions 
of Sale for such products, Intel assumes no liability whatsoever, and Intel disclaims any express or implied warranty, relating 
to sale and/or use of Intel products including liability or warranties relating to fitness for a particular purpose, merchantability, 
or infringement of any patent, copyright or other intellectual property right.  Intel products are not designed, intended or 
authorized for use in any medical, life saving, or life sustaining applications or for any other application in which the failure of 
the Intel® product could create a situation where personal injury or death may occur.  Intel may make changes to 
specifications and product descriptions at any time, without notice.   

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries. 

† Other names and brands may be claimed as the property of others. 

Copyright © 2001, Intel Corporation.  All Rights Reserved.



  iii 

 

Contents 

1 Description 
Server Board Features ......................................................................................................... 7 

Server Board Connector and Component Locations .................................................... 8 
Back Panel Connectors ............................................................................................... 9 
Processor ...................................................................................................................10 
Memory ......................................................................................................................10 

PCI Riser Slots ....................................................................................................................10 
Video...................................................................................................................................11 
SCSI Controller ...................................................................................................................11 
ATA-100 Controller..............................................................................................................11 

IDE RAID....................................................................................................................11 
Network Controller...............................................................................................................12 

Network Teaming Features.........................................................................................12 
Keyboard and Mouse ..........................................................................................................14 
RJ-45 Serial Port .................................................................................................................14 
ACPI....................................................................................................................................16 
Security ...............................................................................................................................17 

Intrusion Switch Monitoring.........................................................................................17 
Software Locks ...........................................................................................................17 

2 Installation Procedures 
Install the I/O Shield ............................................................................................................21 
Rearrange the Standoffs .....................................................................................................22 
Server Board Bumpers ........................................................................................................23 
Install the Server Board .......................................................................................................24 
Installing Processors ...........................................................................................................25 
Install the Processor Terminator..........................................................................................28 
Memory ...............................................................................................................................29 
Connect Cables...................................................................................................................30 

3 Upgrading 
Tools and Supplies Needed.................................................................................................31 
Cautions..............................................................................................................................31 
Memory ...............................................................................................................................32 
Processors ..........................................................................................................................33 

Adding or Replacing a Processor................................................................................34 
Removing a Processor................................................................................................37 
Installing and Removing a Terminator.........................................................................38 

Replacing the Back up Battery ............................................................................................39 

4 Configuration Software and Utilities 
Service Partition (Optional)..................................................................................................41 
Configuration Utilities...........................................................................................................41 

System Software Update Sequence ...........................................................................41 
Hot Keys..............................................................................................................................42 



iv   Intel Server Board SCB2 Product Guide 

Power-On Self-Test (POST) ................................................................................................43 
Using BIOS Setup ...............................................................................................................43 

Record BIOS Setup Settings ......................................................................................44 
If BIOS Setup Is Inaccessible......................................................................................44 

BIOS Setup Menus..............................................................................................................44 
Main Menu..................................................................................................................45 
Advanced Menu..........................................................................................................46 
Security Menu.............................................................................................................49 
Server Menu...............................................................................................................50 
Boot Menu ..................................................................................................................52 
Exit Menu ...................................................................................................................53 

Temporarily Changing the Boot Device Priority ...................................................................53 
Permanently Changing the Boot Device Priority ..................................................................54 
Running the Adaptec SCSISelect Utility ..............................................................................54 

When to Run the Adaptec SCSISelect Utility ..............................................................54 
Running the SCSISelect Utility....................................................................................54 
Configuring the Adaptec AIC-7899 SCSI Adapter .......................................................55 

Running the Promise FastBuild Utility..................................................................................55 
When to Run the Promise FastBuild Utility..................................................................56 
Running the Promise FastBuild Utility .........................................................................56 

Direct Platform Control (DPC) Console ...............................................................................56 
DPC Console Modes of Operation..............................................................................57 
Running the DPC Console..........................................................................................57 

Using the System Setup Utility ............................................................................................57 
What You Need to Do.................................................................................................58 
Running the SSU........................................................................................................58 
Customizing the SSU..................................................................................................59 
Launching a Task .......................................................................................................60 
MultiBoot Options Add-in ............................................................................................60 
Password Add-in.........................................................................................................60 
SEL Manager Add-in ..................................................................................................62 
FRU Manager Add-in..................................................................................................63 
SDR Manager Add-in..................................................................................................64 
System Update Add-In................................................................................................64 
Configuration Save/Restore Add-In ............................................................................65 
Platform Event Manager Add-in ..................................................................................66 
Exiting the SSU ..........................................................................................................74 

Platform Event Paging.........................................................................................................74 
Using Platform Event Paging ......................................................................................74 

Software Updates................................................................................................................75 
Creating a Bootable Diskette ......................................................................................75 

Software Update Package...................................................................................................75 
Preparation.................................................................................................................75 
Extraction ...................................................................................................................76 
Updating .....................................................................................................................76 

Individual Updates...............................................................................................................77 
BIOS Upgrade Description..........................................................................................77 
Firmware Update Utility Description............................................................................79 
FRU/SDR Load Utility Description ..............................................................................79 



Contents   v 

5 Solving Problems 
Resetting the System ..........................................................................................................83 
Initial System Startup...........................................................................................................83 

Checklist .....................................................................................................................83 
Running New Application Software......................................................................................84 

Checklist .....................................................................................................................84 
After the System Has Been Running Correctly ....................................................................84 

Checklist .....................................................................................................................84 
More Problem Solving Procedures ......................................................................................85 

Preparing the System for Diagnostic Testing ..............................................................85 
Monitoring POST ........................................................................................................85 
Verifying Proper Operation of Key System Lights .......................................................85 
Confirming Loading of the Operating System..............................................................85 

Specific Problems and Corrective Actions ...........................................................................86 
Power Light Does Not Light ........................................................................................86 
No Characters Appear on Screen ...............................................................................86 
Characters Are Distorted or Incorrect..........................................................................87 
System Cooling Fans Do Not Rotate Properly ............................................................87 
Diskette Drive Activity Light Does Not Light ................................................................88 
CD-ROM Drive Activity Light Does Not Light ..............................................................88 
Cannot Connect to a Server .......................................................................................88 
Problems with Network ...............................................................................................89 

Problems with Application Software.....................................................................................90 
Bootable CD-ROM Is Not Detected .....................................................................................90 

6 Technical Reference 
Server Board Jumpers.........................................................................................................91 
Diagnostic LEDs..................................................................................................................92 

7 Regulatory and Integration Information 
Product Regulatory Compliance ..........................................................................................97 

Product Safety Compliance ........................................................................................97 
Product EMC Compliance...........................................................................................97 
Product Regulatory Compliance Markings ..................................................................97 

Electromagnetic Compatibility Notices.................................................................................98 
Europe (CE Declaration of Conformity).......................................................................98 
Australian Communications Authority (ACA) (C-Tick Declaration of Conformity).........98 
Ministry of Economic Development (New Zealand) Declaration of Conformity ............98 
BSMI (Taiwan)............................................................................................................98 

8 Equipment Log and Power Consumption Worksheets 
Equipment Log ....................................................................................................................99 

Current Usage ..........................................................................................................101 
Calculating Power Consumption ...............................................................................101 

Index.....................................................................................................................................105 

 



vi   Intel Server Board SCB2 Product Guide 

Figures 
1. Server Board Connector and Component Locations....................................................... 8 
2. Back Panel Connectors .................................................................................................. 9 
3. J6A2 Jumper Block for DCD Signal ...............................................................................15 
4. J6A2 Jumper Block for DSR Signal ...............................................................................15 
5. Installing the I/O Shield..................................................................................................21 
6. Rearrange the Standoffs................................................................................................22 
7. Installing Server Board Bumpers ...................................................................................23 
8. Installing the Server Board.............................................................................................24 
9. Raising the Locking Bar.................................................................................................25 
10. Installing Processors......................................................................................................25 
11. Installing the Heat Sink ..................................................................................................26 
12. Closing the Locking Lever..............................................................................................27 
13. Connecting the Heat Sink Fan .......................................................................................27 
14. Installing the Processor Terminator ...............................................................................28 
15. Installing Memory ..........................................................................................................29 
16. Connecting Cables ........................................................................................................30 
17. Installing DIMMs............................................................................................................32 
18. Insert the Processor and Lower the Locking Bar ...........................................................34 
19. Installing the Heat Sink..................................................................................................35 
20. Attach the Heat Sink......................................................................................................36 
21. Connect the Heat Sink Fan............................................................................................36 
22. Installing a Terminator ...................................................................................................38 
23. Replacing the Back up Battery.......................................................................................40 
24. System Setup Utility Main Window ................................................................................59 
25. Platform Event Manager Main Window..........................................................................66 
26. Platform Event Paging Dialog........................................................................................67 
27. BMC LAN-Configuration Dialog .....................................................................................68 
28. Platform Event Action Dialogs .......................................................................................71 
29. Emergency Management Port Dialog ............................................................................72 
30. Jumper Locations ..........................................................................................................91 

Tables 
1. Server Board Versions.................................................................................................... 7 
2. Server Board Features ................................................................................................... 7 
3. Rear COM2 Port Adapter Pin-out ..................................................................................15 
4. Software Security Features............................................................................................18 
5. Configuration Utilities.....................................................................................................42 
6. Hot Keys  .....................................................................................................................42 
7. BIOS Setup Menu Navigation ........................................................................................44 
8. BIOS Setup Menu Display .............................................................................................45 
9. Command Line Format ..................................................................................................80 
10. Configuration Jumper ....................................................................................................91 
11. Post Codes....................................................................................................................92 
12. Power Usage Worksheet 1 ..........................................................................................102 
13. Power Usage Worksheet 2 ..........................................................................................103 



  7 

 

1 Description 

Server Board Features 
The SCB2 is available in either SCSI or ATA hard drive interface versions as described in Table 1. 
The features listed in Table 2 are common to both server board versions. 

Table 1. Server Board Versions 

Feature Description 

SCSI Dual channel Ultra160 LVD SCSI accessible at rear panel I/O and internally 

ATA Dual channel ATA 100 RAID 

✏  NOTE 

The feature set listed in Table 2 only reflects usage with either the 
1U Intel® SR1200 or the 2U Intel® SR2200 server chassis.  Third-party or 
OEM chassis may not provide all of the features listed below. 

Table 2. Server Board Features 

Feature Description 

Processors Dual processor slots supporting Intel® Pentium® III processors in a Socket370 Flip 
Chip Pin Grid Array (FC-PGA) package.  

Memory Six dual inline memory module (DIMM) slots support: 

• SDRAM DIMMs:  133 MHz, ECC, registered, PC/133 compliant, 72-bit, 168-pin, 
gold contact, 3.3V.  A 1U chassis requires low-profile (LP) 1.2-inch DIMMs. 

• Up to 6 GB of memory in a 2U chassis. 

Graphics Integrated onboard ATI RAGE† XL PCI 64 bit SVGA controller. 

Video Memory 8 MB SDRAM of video memory 

PCI bus Two PCI riser slots capable of supporting either of the following configurations: 

• 1U configuration—one full-length, full-height 64-bit/66-MHz PCI riser slot and one 
Low Profile (LP) 64-bit/66-MHz PCI riser slot. 

• 2U configuration—three full-length, full-height 64-bit/66-MHz PCI riser slots and 
three LP 64-bit/66-MHz PCI riser slots. 

Network Dual on-board 10/100 Network Interface Controllers (NIC) 

System I/O 

(See Table 1) 

• One PS/2† keyboard/mouse port (6 pin DIN) 

• One VGA video port (15 pin) 

• Two external USB ports, internal header providing two additional USB 

• One external serial port (RJ-45), one internal COM 1 header 

• One external SCSI port (SCSI server board only), one internal 

• Two NIC ports (RJ-45) 

Form Factor Server ATX form factor 
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Server Board Connector and Component Locations 

The SCB2 comes in both SCSI and ATA versions.  Figure 1 is a composite view of both versions. 
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A. Speaker 
B. ID LED 
C. Battery 
D. Diagnostic LEDs (POST code) 
E. 66 MHz/64-bit PCI riser slot (full height) 
F. DIMM slots 
G. I/O ports 
H. ICMB connector 
I. COM 1 serial header 
J. Chassis intrusion connector 
K. 66 MHz/64-bit PCI riser slot (low profile) 
L. USB 3 & 4 header 
M. Sys fan 3 connector 
N. CPU 2 fan connector 
O. Secondary processor socket 
P. Primary processor socket 
Q. Sys fan 2 connector 

R. CPU 1 fan connector 
S. Sys fan 1 connector 
T. Aux fan connector 
U. Floppy drive connector 
V. Fan module connector 
W. Main power connector 
X. Auxiliary signal connector 
Y. Floppy/FP/IDE connector 
Z. Alternate front panel connector 
AA. ATA/IDE connector 
BB. IPMB connector 
CC. SSI front panel connector 
DD. Configuration jumper block 
EE. ATA-100 connectors (ATA version only) 
FF. SCSI connector (SCSI version only) 
GG. Hard Disk Drive LED header 

Figure 1.  Server Board Connector and Component Locations 
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Back Panel Connectors 
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A. USB 1 connector 
B. Video connector 
C. SCSI connector (SCSI server board only) 
D. NIC 2 RJ-45 connector 
E. Green Status LED  
F. Yellow Status LED 
G. NIC 1 RJ-45 connector 
H. Green Status LED 
I. Yellow Status LED 
J. PS/2 keyboard/mouse connector 
K. RJ-45 serial port 
L. USB 2 connector 

Figure 2.  Back Panel Connectors 
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Processor 

The SCB2 accommodates one or two Intel Pentium III processors with 512k cache in the FC-PGA2 
package.  This processor uses the .13 micron technology and offers advanced performance.  The 
processor external interface operates at a maximum of 133 MHz.  For a complete list of supported 
processors see: 

http://support.intel.com/support/motherboards/server/scb2 

Memory 

The system board contains six 168-pin DIMM slots each supporting 72-bit ECC (64-bit main 
memory plus ECC) registered SDRAM DIMMs (PC-133 compatible).  Memory is two-way 
interleaved and partitioned in three banks.  You may install a minimum of 128 MB (64MB x 2) and 
as much as 6 GB. 

The controller automatically detects, sizes, and initializes the memory array, depending on the type, 
size, and speed of the installed DIMMs, and reports memory size and allocation to the server via 
configuration registers. 

✏  NOTE 

Use DIMMs that have been tested for compatibility with the server board.  
Contact your sales representative or dealer for a current list of approved 
memory modules.  Check the Intel Customer Support website for the latest 
tested memory list:  

http://support.intel.com/support/motherboards/server/scb2 

PCI Riser Slots 
The server board has two PCI riser slots, each capable of supporting 64-bit/66-MHz PCI riser cards. 
PCI features: 

• Bus speed up to 66 MHz  
• 32 bit memory addressing 
• 5 V/3.3 V signaling environment 
• Burst transfers of up to 512 Mbps 
• 8, 16, 32, or 64-bit data transfers 
• Plug and Play ready 
• Parity enabled 



Description   11 

Video 
The SCB2 uses an ATI RAGE XL PCI graphics accelerator with 8 MB of video SDRAM that 
supports all standard IBM† VGA modes.  The embedded SVGA video subsystem supports: 

• Pixel resolutions up to 1600 x 1200 under 2D and 1024 x 768 under 3D 
• CRT and LCD monitors up to 100 Hz vertical refresh rate 

The server board supports disabling of the onboard video through the BIOS setup menu or when a 
plug in video card is installed in any of the PCI slots. 

SCSI Controller 
The SCSI version of the server board includes an embedded Adaptec† AIC-7899W controller 
providing dual Ultra160 Low Voltage Differential (LVD) SCSI channels. 

The SCSI bus is terminated on the server board with active terminators that cannot be disabled.  
The onboard device must always be at one end of the bus.  The device at the other end of the cable 
must also be terminated.  LVD devices generally do not have termination built-in and need to have 
a termination source provided.  Non-LVDs devices generally are terminated through a jumper or 
resistor pack on the device itself. 

ATA-100 Controller 
The ATA version of the server board provides an embedded dual channel ATA-100 bus through the 
use of the Promise Technology† PDC20267 ATA-100 controller.  The controller contains two 
independent ATA-100 channels that share a single 32-bit, 33-MHz PCI bus master interface as a 
multifunction device.  The controller supports: 

• DMA and PIO IDE drives and ATAPI devices 
• ATA and ATAPI proposal PIO Mode 0, 1, 2, 3, 4; DMA Mode 0, 1, 2; and 

Ultra DMA Mode 0, 1, 2, 3, 4, 5 
• IDE transfer rates up to 100 MB/sec per channel 
• Buffering for PCI/IDE burst transfers 
• Master/slave IDE mode 
• Host interface complies with PCI Local Bus Specification Revision 2.2 

IDE RAID 

The ATA-100 controller supports IDE RAID through both ATA-100 channels.  In a RAID 
configuration, multiple IDE hard drives are placed into one or more arrays of disks. Each array is 
seen as an independent disk, though the array may include one, two, three, or four drives.  The IDE 
RAID can be configured as follows: 

• RAID 0: Striping one to four drives 
• RAID 1: Mirroring two drives 
• RAID 1 +: Spare drive (three drives) 
• RAID 0 +: One to four drives are required 
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RAID 0 configurations are used for high performance applications, as it doubles the sustained 
transfer rate of its drives. RAID 1 configurations are primarily used for data protection. It creates an 
identical drive backup to a secondary drive. Whenever a disk write is performed, the controller 
sends data simultaneously to a second drive located on a different data channel. With 4 drives 
attached to dual ATA-100 channels, two striped drive pairs can mirror each other (RAID 0+1) for 
storage capacity and data redundancy. 

Network Controller 

✏  NOTE 

To ensure EMC product regulation compliance, the system must be used 
with a shielded LAN cable. 

The server board uses two Intel® 82550PM Fast Ethernet† Controllers and supports two 
10Base-T/100Base-TX network subsystems.  

The 82550 PM controller supports the following features: 

• 32-bit PCI, CardBus master interface  
• Integrated IEEE 802.3 10Base-T and 100Base-TX compatible PHY† 
• IEEE 820.3u auto-negotiation support 
• Chained memory structure similar to the 82559, 82558, 82557 and 82596 
• Full duplex support at both 10 Mbps and 100 Mbps operation 
• Low power +3.3 V device 
• IP checksum off-loading 

On the SCB2, NIC 1 can be used as both a network interface and server management interface. 

NIC Connector and Status LEDs 
The 82550 controller drives LEDs on the network interface connector that indicate link/activity on 
the LAN and 10- or 100-Mbps operation.  The green LED indicates network connection when on 
and TX/RX activity when blinking.  The yellow LED indicates 100-Mbps operation when lit. 

Network Teaming Features 

✏  NOTE 

Using both on-board NICs in a team does not allow the use of NIC 1 for  
server management access.  To support both network teaming features and 
server management features, a third NIC must be added and teamed to NIC 2. 
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The network controller provides several options for increasing throughput and fault tolerance when 
running Windows NT† 4.0, Windows† 2000 , NetWare† 4.1x or newer, or Linux†: 

• Adapter Fault Tolerance (AFT) - provides automatic redundancy for your adapter.  If the 
primary adapter fails, the secondary takes over.  AFT works with any hub or switch. 

• Adaptive Load Balancing (ALB) - creates a team of 2 - 8 adapters to increase transmission 
throughput.  Also includes AFT.  Works with any 10Base-TX or 100Base-TX switch. 

• Fast EtherChannel† (FEC) or Intel® Link Aggregation - creates a team of up to 8 adapters to 
increase transmission and reception throughput.  Also includes AFT.  Requires a FEC-enabled 
switch. 

To set up an option, read the instructions in the Windows NT 4.0 or NetWare 4.1x readme files. 

General Configuration Notes 

1. Windows NT versions prior to 4.0 do not support Adapter Teaming options. 
2. Adapter Teaming options require NT 4.0 with Service Pack 4.0 or Service Pack 3.0 and the 

Windows Hot Fix†. 
3. In Windows NT, teaming options cannot be implemented on adapters that have been 

configured for VLANs.  NetWare can support teaming options and VLANs on the same 
adapters. 

Adapter Fault Tolerance 
Adapter Fault Tolerance (AFT) is a simple, effective, and fail-safe approach to increase the 
reliability of server connections.  AFT gives you the ability to set up link recovery to the server 
adapter in case of a cable, port, or network interface card failure.  By assigning two server adapters 
as a team, AFT enables you to maintain uninterrupted network performance. 

AFT is implemented with two server adapters:  a primary adapter and a backup, or secondary, 
adapter.  During normal operation, the backup will have transmit disabled.  If the link to the 
primary adapter fails, the link to the backup adapter automatically takes over. 

Preferred Primary Adapter  

With multiple adapters installed, you can specify one as the Preferred Primary adapter.  For 
example if you have a server with a PRO/1000 server adapter as the primary adapter and a 
PRO/100+ adapter as the secondary, you could configure the PRO/1000 server adapter to be the 
preferred primary.  In this scenario, if the PRO/1000 server adapter fails, the PRO/100+ will take 
over.  Then when the PRO/1000 server adapter is replaced, it will automatically revert to being the 
primary adapter in the team. 

If a Preferred Primary is not selected, PROSet will attempt to select the best adapter, based on 
adapter model and speed. 

Mixed Adapter Teaming 

AFT supports up to eight server adapters per team, in any mix. 
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Adaptive Load Balancing 
Adaptive Load Balancing (ALB) is a simple and efficient way to increase your server’s transmit 
throughput.  With ALB you group server adapters in teams to provide an increased transmit rate 
(up to 8 Gbps) using a maximum of eight adapters.  The ALB software continuously analyzes 
transmit loading on each adapter and balances the rate across the adapters as needed.  Adapter 
teams configured for ALB also provide the benefits of AFT.  Receive rates remain at 100 Mbps or 
1 Gbps depending on the primary adapter’s capability. 

To use ALB, you must have 2-8 server adapters installed in your server or workstation and linked 
to the same network switch. 

Cisco† Fast EtherChannel 
Fast EtherChannel (FEC) is a performance technology developed by Cisco to increase your server’s 
throughput.  Unlike ALB, FEC can be configured to increase both transmission and reception 
channels between your server and switch.  FEC works only with FEC-enabled switches, such as the 
Catalyst 5000 series.  With FEC, as you add adapters to your server, you can group them in teams 
to provide up to 18 Gbps at full duplex, with a maximum of 8 server adapters.  The FEC software 
continuously analyzes loading on each adapter and balances network traffic across the adapters as 
needed.  Adapter teams configured for FEC also provide the benefits of AFT. 

To use FEC, you must have 2, 4, or 8 server adapters installed in your server and linked to the same 
FEC-enabled Cisco switch. 

Keyboard and Mouse 
The keyboard/mouse controller is PS/2-compatible.  If specified through the System Setup Utility 
(SSU), the server may be locked automatically if there is no keyboard or mouse activity for a 
predefined length of time.  Once the inactivity (lockout) timer has expired, the keyboard and mouse 
do not respond until the previously stored password is entered.  A Y-cable can be used if both a 
PS/2 mouse and keyboard are required at the same time. 

RJ-45 Serial Port 
The rear RJ-45 serial port is a fully functional COM port that supports any standard serial device 
and provides support for serial concentrators, which typically support RJ45 serial connectors. For 
server applications that use a serial concentrator to access the server management features of the 
baseboard, a standard 8-pin CAT-5 cable from the serial concentrator is plugged directly into the 
rear RJ45 serial port. The 8 pins of the RJ45 connector can be configured to match either of two 
pin-out standards used by serial port concentrators. To accommodate either standard, the 
J6A2 jumper block located directly behind the rear RJ45 serial port must be jumpered appropriately 
according to which standard is desired.  
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DSR to Pin#7 

DCD to Pin#7 

DSR to Pin#7 

DCD to Pin#7 

✏  NOTE 

By default, as configured in the factory, the SCB2 baseboard will have the 
rear RJ45 serial port configured to support a DSR signal. 

For serial concentrators that require a DCD signal, the J6A2 jumper block must be configured as 
follows: The DCD jumper in position 2 and 3 and the DSR jumper in position 2 and 3. Pin 1 on the 
jumper is denoted by an arrow directly next to the jumper block.  See Figure 3 on page 15 for the 
jumper block pin-out of this configuration. 

 

 
 
 

Figure 3.  J6A2 Jumper Block for DCD Signal 

For serial concentrators that require a DSR signal, the J6A2 jumper block must be configured as 
follows: The DSR jumper in position 1 and 2 and the DCD jumper in position 1 and 2.  Pin 1 on the 
jumper is denoted by an arrow directly next to the jumper block.  See Figure 4. 

   

 
 
 

Figure 4.  J6A2 Jumper Block for DSR Signal 

For those server applications that require a DB9 type of serial connector, an 8-pin RJ45-to-DB9 
adapter must be used. The following table defines the pin-out required for the adapter to provide 
RS232 support. 

Table 3. Rear COM2 Port Adapter Pin-out 

RJ45 Signal  Abbreviation DB9 

1 Request to Send RTS 7 

2 Data Terminal Ready DTR 4 

3 Transmitted Data TD 3 

4 Signal Ground SGND 5 

5 Ring Indicator RI 9 

6 Received Data RD 2 

7 DCD or DSR DCD/DSR 1 or 6 

8 Clear To Send CTS 8 
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✏ NOTE 
The RJ45-to-DB9 adapter should match the configuration of the serial device 
used. One of two pin-out configurations are used depending on whether the 
serial device requires a DSR or DCD signal. The final adapter configuration 
should also match the desired pin-out of the RJ45 connector, as it can also be 
configured to support either DSR or DCD.   

For systems configured with both a front and rear RJ45 serial connectors, the 
adapters used for the rear port cannot be used with the front port, as the pin-
out for both RJ45 ports are different.  For example, modem applications 
typically use DCD. In this case the user would use a DCD-configured adapter 
and set the jumper block as shown in Figure 3. 

ACPI 
The SCB2 supports the Advanced Configuration and Power Interface (ACPI) as defined by the 
ACPI 1.0 and PC97 specifications.  An ACPI aware operating system can put the system into a 
state where the hard drives spin down, the system fans stop, and all processing is halted.  However, 
the power supply will still be on and the processors will still be dissipating some power, so the 
power supply fans will still run. 

The SCB2 supports sleep states s0, s1, s4, and s5: 

• s0:  Normal running state. 
• s1:  Processor sleep state.  No context will be lost in this state and the processor caches will 

maintain coherency. 
• s4:  Hibernate or Save to Disk:  The memory and machine state are saved to disk.  Pressing the 

power button or other wakeup event will restore the system state from the disk and resume 
normal operation.  This assumes that no hardware changes have been made to the system while 
it was off. 

• s5:  Soft off:  Only the RTC section of the CSB and the BMC are running in this state.  No 
context is saved by the OS or hardware. 

 CAUTION 
The system is off only when the AC power cord is disconnected. 
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Security 

Intrusion Switch Monitoring 

To help prevent unauthorized entry or use of the server, Intel® Server Control server management 
software monitors the chassis intrusion switch if one is installed.  Opening an access cover will 
transmit an alarm signal to the server board, where BMC firmware and server management 
software process the signal.  The system can be configured through ISC to respond to an intrusion a 
number of ways, including powering down or locking the keyboard. 

Software Locks 

The BIOS Setup and the System Setup Utility (SSU) provide a number of security features to 
prevent unauthorized or accidental access to the system.  Once the security measures are enabled, 
you can access the system only after you enter the correct password(s).  For example: 

• Enable the keyboard lockout timer so that the server requires a password to reactivate the 
keyboard and mouse after a specified time out period 1 to 120 minutes. 

• Set and enable a supervisor password. 
• Set and enable a user password. 
• Set secure mode to prevent keyboard or mouse input and to prevent use of the front panel reset 

and power switches. 
• Activate a hot key combination to enter secure mode quickly. 
• Disable writing to the diskette drive when secure mode is set. 
• Disable access to the boot sector of the operating system hard disk drive. 

Using Passwords 
You can set either the user password, the supervisor password, or both passwords.  If only the user 
password is set, you: 

• Must enter the user password to enter BIOS Setup or the SSU. 
• Must enter the user password to boot the server if Password on Boot is enabled in either the 

BIOS Setup or SSU. 
• Must enter the user password to exit secure mode. 

If only the supervisor password is set, you: 

• Must enter the supervisor password to enter BIOS Setup or the SSU. 
• Must enter the supervisor password to boot the server if Password on Boot is enabled in either 

the BIOS Setup or SSU. 
• Must enter the supervisor password to exit secure mode. 

If both passwords are set, you: 

• May enter the user password to enter BIOS Setup or the SSU.  However, you will not be able to 
change many of the options. 
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• Must enter the supervisor password if you want to enter BIOS Setup or the SSU and have 
access to all of the options. 

• May enter either password to boot the server if Password on Boot is enabled in either the BIOS 
Setup or SSU. 

• May enter either password to exit secure mode. 

Secure Mode 
Configure and enable the secure boot mode by using the SSU.  When secure mode is in effect: 

• You can boot the server and the operating system will run, but you must enter the user 
password to use the keyboard or mouse. 

• You cannot turn off system power or reset the server from the front panel switches. 

Secure mode has no effect on functions enabled via remote server management or power control 
via the watchdog timer. 

Taking the server out of secure mode does not change the state of system power.  That is, if you 
press and release the power switch while secure mode is in effect, the system will not be powered 
off when secure mode is later removed.  However, if the front panel power switch remains 
depressed when secure mode is removed, the server will be powered off. 

Summary of Software Security Features 
The table below lists the software security features and describes what protection each offers.  In 
general, to enable or set the features listed here, you must run the SSU and go to the Security 
Subsystem Group, menu.  The table also refers to other SSU menus and to the Setup utility. 

Table 4. Software Security Features 

Feature Description 

Secure mode How to enter secure mode: 

• Setting and enabling passwords automatically places the system in secure 
mode. 

• If you set a hot-key combination (through Setup), you can secure the system 
simply by pressing the key combination.  This means you do not have to wait for 
the inactivity time-out period. 

When the system is in secure mode: 

The server can boot and run the operating system, but mouse and keyboard input 
is not accepted until the user password is entered. 

At boot time, if a CD is detected in the CD-ROM drive or a diskette in drive A, the 
system prompts for a password.  When the password is entered, the server boots 
from CD or diskette and disables the secure mode. 

If there is no CD in the CD-ROM drive or diskette in drive A, the server boots from 
drive C and automatically goes into secure mode.  All enabled secure mode 
features go into effect at boot time. 

To leave secure mode:  Enter the correct password(s). 

Disable writing to 
diskette 

In secure mode, the server will not boot from or write to a diskette unless a 
password is entered.   

To write protect access to diskette whether the server is in secure mode or not, use 
the Setup main menu, Floppy Options, and specify Floppy Access as read only. 

continued 



Description   19 

Table 4. Software Security Features (continued) 

Feature Description 

Set a time out period 
so that keyboard and 
mouse input are not 
accepted 

Also, screen can be 
blanked, and writes to 
diskette can be 
inhibited 

Specify and enable an inactivity time out period of from 1 to 120 minutes. 

If no keyboard or mouse action occurs for the specified period, attempted keyboard 
and mouse input will not be accepted. 

The monitor display will go blank, and the diskette drive will be write protected 
(if these security features are enabled through Setup). 

To resume activity:  Enter the correct password(s). 

Control access to 
using the SSU:  set 
supervisor password 

To control access to setting or changing the system configuration, set a supervisor 
password and enable it through Setup. 

If both the supervisor and user passwords are enabled, either can be used to boot 
the server or enable the keyboard and/or mouse, but only the supervisor password 
will allow Setup to be changed. 

To disable a password, change it to a blank entry or press CTRL-D in the Change 
Password menu of the Supervisor Password Option menu found in the Security 
Subsystem Group. 

To clear the password if you cannot access Setup, change the Clear Password 
jumper (see Chapter 5). 

Control access to the 
system other than 
SSU:  set user 
password 

To control access to using the system, set a user password and enable it through 
Setup. 

To disable a password, change it to a blank entry or press CTRL-D in the Change 
Password menu of the User Password Option menu found in the Security 
Subsystem Group. 

To clear the password if you cannot access Setup, change the Clear Password 
jumper (see Chapter 5). 

Boot without 
keyboard 

The system can boot with or without a keyboard.  During POST, before the system 
completes the boot sequence, the BIOS automatically detects and tests the 
keyboard if it is present and displays a message.   

Specify the boot 
sequence 

The sequence that you specify in setup will determine the boot order.  If secure 
mode is enabled (a user password is set), then you will be prompted for a 
password before the server fully boots.  If secure mode is enabled and the “Secure 
Boot Mode” option is also enabled, the server will fully boot but will require a 
password before accepting any keyboard or mouse input. 
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2 Installation Procedures 

Install the I/O Shield 

✏  NOTE 

An ATX 2.03-compliant I/O shield is provided with the server board.  The 
shield is required by Electromagnetic Interference (EMI) regulations to 
minimize EMI.   If the shield does not fit the chassis, obtain a properly sized 
shield from the chassis supplier.  The I/O shield does not support the use of 
the USB 2 connector. 

The shield fits the rectangular opening in the back of a chassis.  The shield has cutouts that match 
the I/O ports. 

1. Install the shield from inside the chassis.  Orient the shield so that the cutouts align with the 
corresponding I/O connectors on the server board.  Make sure the metal fingers are on the 
inside of the chassis. 

2. Position one edge (A) so that the dotted groove is outside the chassis wall, and the lip of the 
shield rests on the inner chassis wall. 

3. Hold the shield in place, and push it into the opening (B) until it is seated.  Make sure the 
I/O shield snaps into place all the way around. 
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Figure 5. Installing the I/O Shield 
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Rearrange the Standoffs 
If your chassis does not have board mount standoffs placed as shown, you must rearrange them so 
they match the holes in the server board.  Failure to properly rearrange the metal standoffs may 
cause the server board to malfunction and may permanently damage it.  Your chassis may be 
different from the illustration. 
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Figure 6. Rearrange the Standoffs 
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Server Board Bumpers 
If you are installing your server board in a non-Intel chassis, you must provide and install rubber 
bumpers at the locations shown below.  They must be the same height as the existing board mount 
standoffs.  

 CAUTION 
You must install rubber bumpers in all non Intel® chassis that do not already 
support the board at the locations shown in the illustration. 

The rubber bumpers you provide and install must be the same height as the 
existing board mount standoffs to properly support your new board. 

Failure to install bumpers, or installing bumpers that are too tall or too short, 
may damage your board. 

DO NOT INSTALL server board bumpers in the Intel SR1200 and 
SR2200 server chassis. 
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Figure 7. Installing Server Board Bumpers 
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Install the Server Board 
To ensure proper grounding and support, it is recommended that you install screws in all the 
required mounting holes for your chassis.  You may need to move cables out of the way to properly 
install your server board. 

1. While placing the board on the chassis standoffs, carefully position the board I/O connectors 
into the rear chassis I/O openings. 

2. Adjust board position to align mounting holes with standoffs. 
3. Using the screws that came with your chassis, mount the board to the chassis. 

 OM11716A 

Figure 8. Installing the Server Board 
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Installing Processors 
1. Observe the safety and ESD precautions at the beginning of this document. 
2. Raise the locking bar on the socket. 

 OM11711 

Figure 9. Raising the Locking Bar  

3. Aligning the pins of the processor with the socket, insert the processor into the socket. 
4. Lower the locking bar completely. 

OM11712 

Figure 10. Installing Processors 
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5. Following the instructions packaged with the applicator, apply thermal grease to the processor. 
6. Position the heat sink slot (2) above the socket/processor slot (3). 
7. Aligning the raised metal surfaces, place the heat sink on top of the processor. 
8. Install the heat sink clip with pin (1) inserted into slot (2). 

 OM11708A

C

A

B

2

3

1

 

Figure 11. Installing the Heat Sink 

A. Heat sink retention clip 
B. Heat sink 
C. Socket and processor 
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 CAUTION 
Use care when closing the locking lever—do it slowly. 

9. Slowly close the locking lever (A) until it contacts tab (B). 
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Figure 12. Closing the Locking Lever 

✏  NOTE 

When using the boxed Intel Pentium III processor, compatible with the 
SCB2 server board, it will come with a fan for the processor heat sink. This 
fan cannot be used in a 1U server chassis.  If you are integrating a 2U 
chassis, proceed to the next step. 

10. Following the instructions provided with the processor, install the fan on the processor heat 
sink. 

11. Connect the fan to (A) if it is on the primary processor or to (B) if it is on the secondary 
processor. 
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Figure 13. Connecting the Heat Sink Fan 
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Install the Processor Terminator 
If you are installing only one processor, you must install a terminator in the secondary processor 
socket (A).  If you are installing two processors, skip this section. 

1. Raise the locking bar (B) on the socket. 
2. Aligning the two corner marks on the terminator with the handle-side of the socket (C), insert 

the terminator into the socket. 
3. Lower the locking bar completely (D).  
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Figure 14. Installing the Processor Terminator 
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Memory 
Only PC133-compliant SDRAM is supported by the server board.  Install from 128 MB to 6 GB of 
registered, ECC memory, using up to six DIMMs.  A 1U chassis requires low-profile (LP) 1.2-inch 
DIMMs. 

DIMMs must be installed in pairs and in the following order:  1a and 1b, 2a and 2b, 3a and 3b. 

Installed DIMMs must be the same speed and must all be registered.  For a list of supported 
memory, call your service representative or visit the Intel Support website:  

http://support.intel.com/support/motherboards/server 
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Figure 15. Installing Memory 
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Connect Cables 
Before connecting cables, consult the documentation supplied with your chassis. 
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Figure 16. Connecting Cables 

A. SCSI connector (SCSI server board only) 
B. ATA-100 primary/secondary connectors (ATA server board only) 
C. SSI front panel connector (see the server board diagram label for pin out) 
D. Front panel connector (For use in a non Intel chassis only) 
E. IDE connector (For use in a non Intel chassis only) 
F. Main power connector 
G. Fan module connector (7-pin) 
H. Fan connectors (system and processor) 
I. USB header 
J. Floppy connector (For use in a non Intel chassis only) 
K. COM 1 header 
L. Combined Floppy/Front Panel/IDE connector (For use in an Intel chassis only) 
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3 Upgrading 

Tools and Supplies Needed 
• Jumper removal tool or needle nosed pliers 
• Phillips† (cross head) screwdriver (#1 bit and #2 bit) 
• Pen or pencil 
• Antistatic wrist strap and conductive foam pad 

(recommended) 

 

OM11717A 

Cautions 
These warnings and cautions apply throughout this chapter.  Only a technically qualified person 
should configure the server board. 

 CAUTIONS 
System power on/off:  The power button DOES NOT completely turn off 
the system AC power, 5V standby is still active whenever the system is 
plugged in.  To remove power from system, you must unplug the AC power 
cord from the wall outlet.  Make sure the AC power cord is unplugged before 
you open the chassis, add, or remove any components. 

Hazardous conditions, devices & cables:  Hazardous electrical 
conditions may be present on power, telephone, and communication cables.  
Turn off the server and disconnect the power cord, telecommunications 
systems, networks, and modems attached to the server before opening it.  
Otherwise, personal injury or equipment damage can result. 

Electrostatic discharge (ESD) & ESD protection:  ESD can damage 
disk drives, boards, and other parts.  We recommend that you perform all 
procedures in this chapter only at an ESD workstation.  If one is not 
available, provide some ESD protection by wearing an antistatic wrist strap 
attached to chassis ground any unpainted metal surface on your server 
when handling parts. 

ESD and handling boards:  Always handle boards carefully.  They can 
be extremely sensitive to ESD.  Hold boards only by their edges.  After 
removing a board from its protective wrapper or from the server, place the 
board component side up on a grounded, static free surface.  Use a 
conductive foam pad if available but not the board wrapper.  Do not slide 
board over any surface. 
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Installing or removing jumpers:  A jumper is a small plastic encased 
conductor that slips over two jumper pins.  Some jumpers have a small tab on 
top that you can grip with your fingertips or with a pair of fine needle nosed 
pliers.  If your jumpers do not have such a tab, take care when using needle 
nosed pliers to remove or install a jumper; grip the narrow sides of the 
jumper with the pliers, never the wide sides.  Gripping the wide sides can 
damage the contacts inside the jumper, causing intermittent problems with 
the function controlled by that jumper.  Take care to grip with, but not 
squeeze, the pliers or other tool you use to remove a jumper, or you may 
bend or break the stake pins on the board. 

Memory 
The server board supports from 128 MB up to 6 GB of registered memory in six DIMM slots.  

✏  NOTE 
• Only PC133-compliant SDRAM is supported by the server board. 
• A 1U chassis requires low-profile (LP) 1.2-inch (30 mm) tall DIMMs. 
• DIMMs must be populated in pairs and in the following order: 

1a and 1b, then 2a and 2b, then 3a and 3b. 
• Installed DIMMs must be the same speed and must all be registered. 

For a list of supported memory, call your service representative or visit the Intel Customer Support 
website:   

http://support.intel.com/support/motherboards/server/scb2 
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Figure 17.  Installing DIMMs 
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Processors 

 WARNING 
If the server has been running, any installed processor and heat sink on 
the processor board(s) will be hot.  To avoid the possibility of a burn, be 
careful when removing or installing server board components that are 
located near processors. 

 CAUTIONS 
Processor must be appropriate:  You may damage the server if you 
install a processor that is inappropriate for your server.  Make sure your 
server can handle a newer, faster processor (thermal and power 
considerations).  For exact information about processor interchangeability, 
contact your customer service representative or visit the Intel Customer 
Support website: 

http://support.intel.com/support/motherboards/server/scb2 
 

ESD and handling processors:  Reduce the risk of electrostatic 
discharge (ESD) damage to the processor by doing the following:  (1) Touch 
the metal chassis before touching the processor or server board.  Keep part of 
your body in contact with the metal chassis to dissipate the static charge 
while handling the processor.  (2) Avoid moving around unnecessarily. 
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Adding or Replacing a Processor 

If you are adding a second processor to your system, you must first remove the terminator from the 
secondary processor socket (refer to Installing and Removing a Terminator on page 38).  The 
second processor must be compatible with the first processor (within one stepping, same voltage, 
same speed, see the Intel Customer Support website for specifics). 

1. Observe the safety and ESD precautions given at the beginning of this chapter.  
2. Remove the chassis cover (see your system or chassis documentation for instructions). 
3. Raise the locking bar on the socket. 
4. Aligning the pins of the processor with the socket, insert the processor into the socket.   
5. Lower the locking bar completely. 

OM11712 

Figure 18.  Insert the Processor and Lower the Locking Bar 
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6. Follow the instructions packaged with your boxed processor for preparing the heat sink and 
processor for installation. 

7. Position the heat sink slot (2) above the socket/processor slot (3). 
8. Aligning the raised metal surfaces, place the heat sink on top of the processor. 
9. Install the heat sink clip with pin (1) inserted into slot (2). 
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A. Heat sink retention clip 
B. Heat sink 
C. Socket and processor 

Figure 19.  Installing the Heat Sink 

 CAUTION 
Use care when closing the locking lever—do it slowly. 
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10. Slowly close the locking lever (A) until it contacts tab (B). 
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Figure 20.  Attach the Heat Sink 

✏  NOTE 

When using the boxed Intel Pentium III processor, compatible with the 
SCB2S server board, it will come with a fan for the processor heat sink.  
This fan cannot be used in a 1U server chassis.  If you are integrating a 
2U chassis, proceed to the next step. 

 
 

11. Following the instructions provided with the processor, install the fan on the processor 
heat sink. 

12. Connect the fan to (A) if it is on the primary processor or to (B) if it is on the secondary 
processor. 
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Figure 21.  Connect the Heat Sink Fan 
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Removing a Processor  
1. Observe the safety and ESD precautions at the beginning of this chapter and the additional 

cautions given here. 
2. If a heat sink fan is present, unplug it from the server board and remove it from the heat sink. 
3. Disengage the retention clip from the processor socket by slowly opening the locking lever 

until it is vertical. 
4. Remove the processor from the socket. 
5. If you removed the processor from the secondary socket and are not replacing it, you must 

install a terminator in its place. 



38   Intel Server Board SCB2 Product Guide 

Installing and Removing a Terminator 

If you are installing only one processor, you must install a terminator in the secondary processor 
socket (A). 

1. Observe the safety and ESD precautions at the beginning of this chapter and the additional 
cautions given here. 

2. Raise the locking bar on the socket. 
3. To install a terminator, align the two corner marks on the terminator with the handle-side of the 

socket (C) and then insert the terminator into the socket. 
4. To remove a terminator, pull it out of the socket and then replace the it with another terminator 

or install a processor. 
5. Lower the locking bar (B) completely. 
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Figure 22.  Installing a Terminator 
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Replacing the Back up Battery 
The lithium battery on the server board powers the real time clock (RTC) for up to 10 years in the 
absence of power.  When the battery starts to weaken, it loses voltage, and the server settings stored 
in CMOS RAM in the RTC (for example, the date and time) may be wrong.  Contact your customer 
service representative or dealer for a list of approved devices. 

 WARNING 
Danger of explosion if battery is incorrectly replaced.  Replace only with 
the same or equivalent type recommended by the equipment 
manufacturer.  Discard used batteries according to manufacturer’s 
instructions. 

 ADVARSEL! 
Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering.  Udskiftning 
må kun ske med batteri af samme fabrikat og type.  Levér det brugte 
batteri tilbage til leverandøren. 

 ADVARSEL 
Lithiumbatteri - Eksplosjonsfare.  Ved utskifting benyttes kun batteri 
som anbefalt av apparatfabrikanten.  Brukt batteri returneres 
apparatleverandøren. 

 VARNING 
Explosionsfara vid felaktigt batteribyte.  Använd samma batterityp eller 
en ekvivalent typ som rekommenderas av apparattillverkaren.  Kassera 
använt batteri enligt fabrikantens instruktion. 

 VAROITUS 
Paristo voi räjähtää, jos se on virheellisesti asennettu.  Vaihda paristo 
ainoastaan laitevalmistajan suosittelemaan tyyppiin.  Hävitä käytetty 
paristo valmistajan ohjeiden mukaisesti. 



40   Intel Server Board SCB2 Product Guide 

 

To replace the battery: 

1. Before proceeding, record your custom BIOS settings. 
2. Observe the safety and ESD precautions at the beginning of this chapter. 
3. Open the chassis and locate the battery.   
4. Push the upper end of the metal retainer away from the battery—the battery pops up. 
5. Remove the battery from its socket. 
6. Dispose of the battery according to local ordinance. 
7. Remove the new lithium battery from its package. 
8. Being careful to observe the correct polarity, lay the battery in the socket. 
9. Push the battery down—the metal retainer locks the battery in the socket.  
10. Close the chassis. 
11. Run Setup to restore the configuration settings to the RTC. 
12. Restore your custom BIOS settings. 
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Figure 23.  Replacing the Back up Battery 
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4 Configuration Software and Utilities 

Service Partition (Optional) 
When you are setting up your server system, you can install a service partition onto your hard drive.  
The service partition includes utilities, and other software that be run locally or remotely to assist in 
system management.  The service partition uses approximately 30 to 40 MB of hard disk space.   

✏  NOTE 

It is highly recommended that you install the service partition before 
installing an operating system.  For more information, see the Service 
Partition section in the Installation Guide for the Intel Server Control.  This 
document is included on the Resource CD-ROM shipped with your SCB2 
server board. 

Configuration Utilities 

System Software Update Sequence 

When you update the system software, you should do it in the following order. 

1. Update BIOS 
2. Update firmware (BMC & HSC) 
3. Update FRU/SDR 
4. Unplug system for 30 seconds 
5. Clear CMOS via front panel 
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Table 5. Configuration Utilities 

Utility Description and brief procedure Page 

BIOS Setup Use for system configuration of onboard resources, setting boot 
device priority, or setting system security options. 

You can move the CMOS jumper on the system board from the 
default setting (Protect CMOS memory) to the Clear setting; this 
will allow most system configurations to boot. 

43 

Changing Boot Device 
Priority 

Use this option to change the boot device priority temporarily or 
permanently. 

43 

Adaptec SCSISelect† Utility Use to configure or view the settings of the SCSI host adapters and 
onboard SCSI devices in the system. 

54 

Direct Platform Control 
(DPC) Console 

Use to access and monitor the server remotely. 56 

System Setup Utility (SSU) 
and 
Client System Setup Utility 
(CSSU) 

Use for viewing and configuring server management options, 
viewing the system event log (SEL), setting boot device priority, or 
setting system security options. 

The SSU can run either from the configuration software CD or from 
a set of bootable diskettes.  You can create the diskettes from 
the CD. 

The CSSU is run from the service partition via the DPC console.  It 
provides the same functionality as the SSU, but from a remote 
console. 

Information entered via the SSU/CSSU overrides information 
entered via BIOS Setup. 

57 

FRU/SDR Load Utility Use to update the Field Replacement Unit (FRU) and Sensor Data 
Record (SDR) flash components. 

NOTE:  You must run the FRU/SDR Load utility whenever the 
BMC is updated or if you change your processors. 

75, 79 

BIOS Update Utility Use to update the BIOS or recover from a corrupted BIOS update. 75, 77 

Firmware Update Utility Use to update BMC flash ROM or other firmware. 75, 79 

Hot Keys 
Use the numeric pad of the keyboard to enter numbers and symbols. 

Table 6. Hot Keys 

To Do This: Press These Keys 

Secure your system immediately. <Ctrl+Alt>+hot key  (Set your hot key combination 
with the SSU or BIOS Setup.) 

Enter the Adaptec SCSI Utility during POST. <Ctrl+A> (SCSI model only) 

Enter the Promise Technology IDE RAID Utility. <Ctrl+F> (ATA model only) 

Enter BIOS Setup during POST. <F2> 

Abort memory test during POST. <ESC> (Press while BIOS is updating memory size 
on screen.) 

Display a menu for selecting the boot device. <ESC> (Press anytime after memory check.) 

To remove the splash screen. <ESC> 
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Power-On Self-Test (POST) 
Each time you turn on the system the BIOS begins execution of the Power-On Self-Test (POST).  
POST discovers, configures, and tests the processors, memory, keyboard, and most installed 
peripheral devices.  The time needed to test memory depends on the amount of memory installed.  
POST is stored in flash memory. 

1. Turn on your video monitor and system.  After a few seconds, POST begins to run and displays 
a splash screen. 

2. While the splash screen is displayed: 

• Press <F2> to enter the BIOS Setup (see “Using BIOS Setup”) 

OR  

• Press <Esc> to view POST diagnostic messages and change the boot device priority for this 
boot only (see “Temporarily Changing the Boot Device Priority” on page 53.)  

3. After pressing <F2> or <Esc> during POST, you can press <Ctrl+A> to run the SCSISelect 
Utility.  For more information, see “Running the Adaptec SCSISelect Utility” on page 54. 

4. If you do not press <F2> or <Esc> and do NOT have a device with an operating system loaded, 
the boot process continues and the system beeps once.  The following message is displayed: 
Operating System not found 

5. At this time, pressing any key causes the system to attempt a reboot.  The system searches all 
removable devices in the order defined by the boot priority. 

Using BIOS Setup 
This section describes the BIOS Setup options.  Use BIOS Setup to change the system 
configuration defaults.  You can run BIOS Setup with or without an operating system being 
present.  BIOS Setup stores most of the configuration values in battery-backed CMOS; the rest of 
the values are stored in flash memory.  The values take effect when the system is booted.  POST 
uses these values to configure the hardware.  If the values and the actual hardware do not agree, 
POST generates an error message.  You must run BIOS Setup to specify the correct configuration. 

Run BIOS Setup to modify all server board features, such as: 

• Defining the diskette drive 
• Defining the serial port(s) 
• Set time/date (to be stored in RTC) 
• Configure hard drive(s) 
• Specify boot device sequence 
• Enable SCSI BIOS 
• Enable Server Management Features 
• Setup system passwords 
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Run the System Setup Utility (SSU) to setup the following: 

• Enable Server Management Features 
• Read System Event Log (SEL) 
• Read Sensor Data Records 
• Read System FRU Information 
• Specify boot device sequence 
• Setup system passwords 

Record BIOS Setup Settings 

Record your BIOS Setup settings.  If default values ever need restoring (after a CMOS clear, for 
example), you must run BIOS Setup again.  Your record will make this much easier. 

If BIOS Setup Is Inaccessible 

If you have a misconfigured diskette drive, and you cannot use BIOS Setup to correct the problem, 
you might need to clear CMOS memory.  To clear CMOS, either of two methods can be used.  

1. Press the reset button and hold it down for four seconds or more, and then, while holding the 
reset button down, press the power button.  Release both buttons at the same time.  

2. Move the “Clear CMOS” jumper found on the configuration jumper block on the baseboard.  

BIOS Setup Menus 
Table 7. BIOS Setup Menu Navigation 

To: Press: 

Get general help <F1> or <Alt+H> 
Move between menus ← → 
Go to the previous item ↑  
Go to the next Item ↓  
Change the value of an item + or - 
Select an item or display a submenu <Enter> 
Leave a submenu or exit BIOS Setup <Esc> 
Reset to BIOS Setup defaults <F9> 
Save and exit BIOS Setup <F10> 
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Table 8. BIOS Setup Menu Display 

When you see this: What it means: 

An option is grayed out and not accessible You cannot change or configure the option in that 
menu screen for one of the following reasons: 
• The option is auto-configured or auto-detected. 

• The field is informational only. 

• The field is password protected and is accessible 
only by the User or Administrator 

 

 
The rest of this section lists the features that display onscreen after you press <F2> to enter BIOS 
Setup.  We do not describe all the option choices because (1) a few are not user selectable but 
displayed for your information, and (2) many of the choices are relatively self-explanatory. 

Main Menu 
Feature Choices Description 

System Time HH:MM:SS Sets the system time. 
System Date MM/DD/YYYY Sets the system date. 
Floppy Disk A: Not Installed 

1.44/1.25 MB/1.2 MB 3½" 
2.88 MB 3½" 

Selects the diskette type. 

   
Hard Disk Pre-delay Disabled 

Enabled 
Causes the BIOS to insert a delay before 
attempting to detect IDE drives in the 
system 

Primary IDE Master Press <Enter> Enters submenu. 
Primary IDE Slave Press <Enter> Enters submenu. 
Processor Settings Press <Enter> Enters submenu. 
Language English (US)  

French  
Spanish 
German 
Italian 

Selects which language BIOS displays. 

Primary IDE Master and Slave Submenu 
  

Feature Choices Description 

Type None 

Auto 

Informs the system to ignore this drive. 
Allows the system to attempt auto-detection of the drive type.  

Multi-Sector 
Transfers 

Disabled 
2, 4, 8, or 16 sectors 

Determines the number of sectors per block for multisector 
transfers. 
For Type Auto, this field is informational only.  

LBA Mode 
Control 

Disabled  
Enabled 

For Type Auto, this field is informational only. 

PIO Mode Standard 
1, 2, 3, 3/DMA 1, 
4, 4/DMA 2 

 

Ultra DMA 
Mode 

Mode 2 
Mode 4 

Displays the method for moving data to/from the drive. 
This field is informational only. 



46   Intel Server Board SCB2 Product Guide 

Processor Settings Submenu 
 

Feature Choices Description 

Processor Type N/A Reports type of processor(s) installed in system. 

Processor POST Speed N/A Reports the speed of the processor measured at POST. 

Processor Retest Disabled 
Enabled 

Select yes for the BIOS to clear historical processor status 
and retest all processors on the next boot.  

Processor Serial Number Enabled 
Disabled 

If enabled, the system records the serial number of each 
processor. 

Processor 1 CPU ID N/A Reports Stepping for Processor 1. 

Processor 1 L2 Cache Size N/A Reports L2 Cache Size for Processor 1.  This feature does 
not appear if processor 1 is absent or disabled. 

Processor 2 CPU ID N/A Reports Stepping for Processor 2. 

Processor 2 L2 Cache Size N/A Reports L2 Cache Size for Processor 2.  This feature does 
not appear if processor 2 is absent or disabled. 

Advanced Menu 
Feature Choices Description 

PCI Configuration Press <Enter> Enters submenu. 

Peripheral Configuration Press <Enter> Enters Submenu 

Memory Configuration Press <Enter> Enters Submenu 

Advanced Chipset Control Press <Enter> Enters submenu 

Reset Configuration Data No 

Yes 

Select Yes to clear the system configuration data 
during next boot.  System automatically resets to No in 
next boot. 

Plug & Play O/S No 

Yes 

Selecting “No” lets the BIOS configure all the devices 
in the system.  Selecting “Yes” allows the OS configure 
Plug and Play devices. 

NumLock Off 

On 

Enables or disables the “Numlock”  function at power 
up. 
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PCI Configuration Submenu 
 

Feature Choices Description 

USB Function Press <Enter> Enters Submenu 
Onboard NIC 1 Press <Enter> Enters Submenu 
Onboard NIC 2 Press <Enter> Enters Submenu 
Onboard SCSI Press <Enter> Enters Submenu (SCSI model only) 
Onboard R-IDE Press <Enter> Enters Submenu (ATA model only) 
Onboard Video Press <Enter> Enters Submenu 
Riser Card 
Override 

 
Enabled 
Disabled 

This option will only be displayed if a non-Intel chassis is used.  
If enabled, all six options for PCI slots will be displayed 
If disabled, only two options for PCI slots will be displayed 
 

PCI Slot 1B 
ROM 

Enabled 
Disabled 

Used to enable or disable an option ROM that may be present on a 
PCI add-in card installed in the slot. 
In a 2U chassis, options for additional PCI slots PCI bus B will be 
displayed 

PCI Slot 1C 
ROM 

Enabled 
Disabled 

Used to enable or disable an option ROM that may be present on a 
PCI add-in card installed in the slot 
In a 2U chassis, options for additional PCI slots PCI bus C will be 
displayed 

USB Function Submenu 
  

Feature Choices Description 

USB Function Enabled  
Disabled 

Enables the embedded USB controller. 

Onboard NIC1 and 2 Submenu 
 

Feature Choices Description 

Onboard  NIC Enabled 
Disabled 

If enabled, the system uses the embedded NIC. 

Embedded NIC ROM Enabled 
Disabled 

Enables the device option ROM. 

 Onboard SCSI Submenu 
  

Feature Choices Description 

 Onboard   SCSI Enabled 
Disabled 

Enables or disables embedded legacy SCSI controller 
hardware. 

Embedded LVD SCSI ROM Enabled 
Disabled 

Enables the device expansion ROM  

Onboard R-IDE Submenu 
  

Feature Choices Description 

 Onboard   R-IDE Enabled 
Disabled 

 
If disabled, the embedded R-IDE device is turned off and 
the device resources are hidden from the system 

Onboard   R-IDE ROM Enabled 
Disabled 

If enabled, initializes the embedded R-IDE device 
expansion ROM 
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Onboard Video Submenu 
  

Feature Choices Description 

Onboard Video Enabled  
Disabled 

Enables the embedded video controller. 

Peripheral Configuration Submenu 
 

Feature Choices Description 

Serial Port 1 Address Disabled 
3F8 
2F8 
3E8 
2E8 

Used to configure the serial port address.  If console 
redirection is used, verify that the I/O and IRQ are 
identical to values configured in the “Server Setup” 
menu. 

Serial Port 1 IRQ 4 
3 

Used to configure the interrupt for serial port 1. 

Serial Port 2 Address Disabled 
3F8 
2F8 
3E8 
2E8 

Used to configure the serial port address.  If console 
redirection is used, verify that the I/O and IRQ are 
identical to values configured in the “Server Setup” 
menu. 

Serial Port 2 IRQ 4 
3 

Used to configure the interrupt for serial port 2. 

Diskette Controller Enabled 
Disabled 

Used to enable or disable the onboard floppy disk 
controller. 

Legacy USB Support Disabled 
Keyboard Only 

Auto 

Keyboard & Mouse 

Enables support for legacy USB. 

Front Panel USB Disabled 

Enabled 

Used to enable the USB ports accessed through the 
internal USB header found on the baseboard. 

Memory Configuration Submenu 

Feature Choices Description 

Extended Memory Test 1 MB 

1 KB 

Every Location 

Disabled 

Extended memory test options run during POST.  

Note: the smaller the increment, the longer the test 
takes during POST. 

Bank #1 N/A Informational screen used to display whether DIMMs 
are present in bank #1 

Bank #2 N/A Informational screen used to display whether DIMMs 
are present in bank #2 

Bank #3 N/A Informational screen used to display whether DIMMs 
are present in bank #3 

Memory Retest Disabled 

Enabled 

If enabled, BIOS will activate and retest all DIMMs on 
the next system boot.  This option will be automatically 
reset to disabled on the next system boot. 
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Advanced Chipset Control Submenu 
 

Feature Option Description 

Wake on Ring Disabled 

Enabled 

Legacy wake only: Determines the action of the system when 
the system power is off and the modem is ringing. 

Wake on LAN Disabled 

Enabled 

Legacy wake only: Determines the action of the system when 
a LAN wake up event occurs. 

Wake on PME Disabled 

Enabled 

Legacy wake only: Determines the action of the system when 
a PCI Power Management Enable wake up event occurs. 

Wake on RTC Alarm Disabled 

Enabled 

Legacy wake only: Determines the action of the system when 
a RTC Alarm Wake up event occurs. 

Security Menu 

Enabling the Supervisor Password field requires a password for entering BIOS Setup.  The 
passwords are not case sensitive. 

Feature Choices Description 

User Password is Installed 
Not Installed 

Informational Only.   

Administrator 
Password is 

Installed 
Not Installed 

Informational Only.   

Set 
Administrative 
Password 

Press <Enter> When the <Enter> key is pressed, a password prompt appears.  Press 
ESC key to abort.  Once set, this can be disabled by setting it to a null 
string or by clearing password jumper on server board.   

Set User 
Password 

Press <Enter> When the <Enter> key is pressed, a password prompt appears.  Press 
ESC key to abort.  Once set, this can be disabled by setting it to a null 
string or by clearing password jumper on server board.   

User Access 
Level 

Limited 
No Access 
View Only 
Full 

Sets the User access level for various BIOS setup functions. 

Password on 
Boot 

Disabled 
Enabled 

If your password is set and enabled, the system prompts you for a 
password before it boots. 

Secure Mode 
Timer 

1 minute 
2 minutes 
5 minutes 
10 minutes 
20 minutes 
60 minutes 
120 minutes 

Period of PS/2 keyboard and/or mouse inactivity specified for secure 
mode to activate. A password is required for secure mode to function. 
This option only appears on the screen after a “user” password has 
been entered. 

Secure Mode Hot 
Key 
(CTRL-ALT- ) 

Z 
L 

Key assigned to invoke secure mode features cannot be enabled 
unless at least one password is set. 
This option only appears on the screen after a “user” password has 
been entered. 

Secure Mode 
Boot 

Disabled 
Enabled 

System boots in secure mode. The user must enter a password to 
unlock the system. 
This option only appears on the screen after a “user” password has 
been entered. 

continued 
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Security Menu (continued) 

Feature Choices Description 

Video Blanking Disabled 
Enabled 

Blank video when secure mode is activated. A pass word is required 
to unlock the system. 
This option only appears on the screen after a “user” password has 
been entered. 

Power Switch 
Inhibit 

Disabled 
Enabled 

When enabled, the power switch is inoperable. 
This option only appears on the screen after a “user” password has 
been entered. 

Server Menu 
Feature Choices Description 

System Management Press <Enter> Enters Submenu. 

Console Redirection Press <Enter> Enters Submenu. 

Event Log Configuration Press <Enter> Enters Submenu 

Service Boot Enable 
Disable 

If enabled, server boots directly to System 
Management.  

Assert NMI on PERR Disabled 
Enabled 

If enabled, PCI bus parity error (PERR) routes to NMI. 

Assert NMI on SERR Disabled 
Enabled 

If enabled, PCI bus system error (SERR) routes to NMI. 

FRB-2 Policy Disable BSP 
Do not Disable BSP 
Retry 3 Times 

Controls the policy of the FRB-2 timeout. This option 
determines when the Boot Strap Processor (BSP) 
should be disabled if an FRB-2 error occurs. 

BMC IRQ Disabled 
IRQ 5 
IRQ 11 

Sets the BMC IRQ. 

After Power Failure Stays Off 

Last State 

Power On 

Determines the mode of operation if a power loss 
occurs. 

Temperature Sensor Disabled 

Enabled 

If enabled, the system will not boot if the ambient 
system temperature is outside the range specified in the 
Sensor Data Record (SDR). 

POST Error Pause Disabled 

Enabled 

If enabled, the system will wait for user intervention on 
critical POST errors. 

Platform Event Filtering Disabled  

Enabled 

Enable/Disable triggers for system sensor events inside 
the Baseboard Management Controller (BMC). 
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System Management Submenu 
 

Feature Choices Description 

Board Part Number N/A Information field only 

Board Serial Number N/A Information field only 

System Part Number N/A Information field only 

System Serial Number N/A Information field only 

Chassis Part Number N/A Information field only 

Chassis Serial Number N/A Information field only 

BIOS Revision N/A Information field only 

BMC Revision N/A Information field only 

Primary HSBP Revision N/A Information field only 

Console Redirection Submenu 
 

Feature Choices Description 

Serial Console 
Redirection  

Disabled 
Enabled 

If enabled, BIOS uses the specified serial port to redirect the 
console to a remote ANSI terminal.  Enabling this option will 
disable the Quiet Boot option. 

Serial Port 
 

COM1 3F8 IRQ4 
COM2 2F8 IRQ3 

Serial port and IRQ designated for server management features. 
Make sure these values are identical to those of Serial Port A and 
B in the Peripheral Configuration Setup menu. 

Baud Rate 9600 
19.2k 
38.4k 
115.2k 

Console Redirection, when enabled, uses the baud rate specified. 
When the Direct Platform Control (DPC) shares the COM port as 
console redirection, set the baud rate to 19.2k to match DPC baud 
rate, unless the autobaud feature is used. 

Flow Control No flow control 
CTS/RTS 
XON/XOFF 
CTS/RTS + CD 

None, disallows flow control. 
CTS/RTS is hardware based flow control. 
XON/XOFF is software flow control. 
CTS/RTS +CD is hardware based plus carrier-detect flow control. 
When DPC is sharing the COM port as Console Redirection, set 
the flow control to XON/XOFF or XON/XOFF+CD depending 
whether a modem is used. 

Event Log Configuration Submenu 
 

Feature Choices Description 

Clear All Event 
Logs 

No 
Yes 

Setting this option to YES will clear the DMI event log after a system 
reboot. 

Event Logging Enabled 
Disabled 

When enabled, all systems events are logged. 

Critical Event 
Logging 

Enabled 
Disabled 

If enabled, BIOS will detect and log events for system critical errors.  
Critical errors are fatal to system operation.  These errors include 
PERR, SERR, ECC, Memory errors and NMI. 
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Boot Menu 
 

Feature Choices Description 

Quiet Boot Disabled 
Enabled 

Disabled, displays normal POST messages. 
Enabled, displays OEM Logo instead of POST 
messages.  Enabling this option disables serial 
redirection. 

Boot Device Priority Press <Enter> Enters submenu. 

Hard Drive Press <Enter> Enters submenu. 

Removable Devices Press <Enter> Enters submenu. 

ATAPI CDROM Drives Press <Enter> Enters submenu. 

Boot Device Priority Submenu 
Use the up- or down-arrow keys to select a device.  Press the <+> or <-> keys to move the device 
higher or lower in the boot priority list. 

 

Boot Priority Device Description 

1st Boot Device Removable Devices Attempts to boot from a removable media device. 

2nd Boot Device Hard Drive Attempts to boot from a hard drive device. 

3rd Boot Device ATAPI CD-ROM Drive Attempts to boot from an ATAPI CD-ROM drive.  

4th Boot Device Intel Boot Agent 
version 4 

Attempts to boot from a network when a network device 
controlled by a PXE compliant ROM is present in the system.  

Hard Disk Submenu 
For options on this menu, use the up or down arrow keys to select a device.  Press the <+> or <-> 
keys to move the device higher or lower in the boot priority list. 

 

Option Description 

1.  Drive #1 (or actual drive string) 

2.  Other bootable cards 
(additional entries for each drive that 
has a PnP header) 

Other bootable cards cover all the boot devices not reported to 
the system BIOS through BIOS Boot Specification 
mechanisms.  It may or may not be bootable, and may not 
correspond to any device. 

Removable Devices Submenu 
For options on this menu, use the up or down arrow keys to select a device. 

 

Feature Option Description 

Lists Bootable Removable devices in 
the system. 

Select one of the 
detected devices 

This list includes legacy 1.44-MB floppy 
drives and 120-MB floppy drives. 
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ATAPI CDROM Drives Submenu 
For options on this menu, use the up or down arrow keys to select a device. 

 

Feature Option Description 

Lists Bootable Removable devices in 
the system. 

Select one of the 
detected devices 

This includes any ATAPI CDROM Drive 
installed 

Exit Menu 

You can make the following selections on the Exit Menu.  Select an option using the up or down 
arrow keys.  Press <Enter> to run the option.  Pressing <Esc> does not exit this menu.  You must 
select one of the items from the menu or menu bar to exit. 

 

Choices Description 

Exit Saving Changes  Exits and saves changes to CMOS. 

Exit Discarding Changes Exits without saving changes to CMOS.  BIOS Setup utility is exited 
and POST continues. 

Load BIOS Setup Defaults Loads factory default values for all BIOS Setup data. 

Load Custom Defaults Loads custom defaults saved from previous Custom Save. 

Save Custom Defaults Saves new BIOS settings and stores them as custom default values. 

Discard Changes Discards any changes made to BIOS settings and restores previous 
settings. 

Temporarily Changing the Boot Device Priority 
During POST, you can change the boot device priority for the current boot process.  The changes 
are not saved for the next boot process. 

1. Boot the server. 
2. At any time during POST, press <Esc>.  When POST completes, a popup Boot menu displays. 
3. Use the arrow keys to highlight the device you want the server system to boot from first.  For 

example, if you want the server system to boot from the CD-ROM first, you select  
"CD-ROM Drive." 

✏  NOTE 

One of the selections on the popup Boot menu is "Enter Setup.”  Selecting 
this option brings you into the BIOS Setup.  For more information about the 
BIOS Setup, see “Using BIOS Setup” on Page 43. 

4. Press <Enter>. 
5. The boot process continues.  When finished, a system prompt displays. 
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Permanently Changing the Boot Device Priority  
You can change the boot device permanently.  These changes are saved from boot to boot. 

1. Enter Setup. 
2. From the Setup screen, select Boot Menu. 
3. Select Boot Device Priority, and press <Enter>. 
4. In the Boot Device Priority screen, use the up- or down-arrow keys to select the drive you want 

to boot from, then press the <+> key to move it to the top of the list. 
5. Set the second and third boot devices in the same manner as step 4. 
6. Press the <F10> key to save your changes and exit Setup. 
7. When the Exit prompt appears, press <Enter> again. 
8. The boot process continues.  When finished, an operating system prompt displays. 

Running the Adaptec SCSISelect Utility 
Each host adapter includes an onboard SCSISelect configuration utility that allows you to 
configure/view the settings of the host adapter and devices in the server. 

The system finds the Adaptec AIC-7899 SCSI host adapter and displays the message 
Adaptec AIC-7899 SCSI BIOS V x.xxx where x.xxx is the version number of the 
SCSISelect utility.  Pressing <Ctrl+A> at this time allows you to configure the  
Adaptec AIC-7899 SCSI host adapter. 

When to Run the Adaptec SCSISelect Utility 

Use the SCSISelect utility to: 

• Change default values 
• Check and/or change SCSI device settings that may conflict with those of other devices in 

the server 
• Do a low-level format on SCSI devices installed in the server 

Running the SCSISelect Utility 
1. When this message appears on the video monitor: 

<<<Press <Ctrl><A> for SCSISelect(TM) Utility!>>> 

2. Press <Ctrl+A> to run the utility.  When the main menu for the host adapter appears, choose 
the device that you want to configure—each SCSI bus accepts up to 15 devices.  



Configuration Software and Utilities  55 

Use the following keys to navigate through the menus and submenus: 

SCSISelect Navigation Keys 

Press To 

ESC Exit the utility 

Enter Select an option 

↑  Return to a previous option 

↓  Move to the next option 

F5 Switch between color and monochrome 

F6 Reset to host adapter defaults 

Configuring the Adaptec AIC-7899 SCSI Adapter 

The Adaptec AIC-7899 SCSI adapter has two busses.  Select the bus from the following menu: 

Main Menu 

Menu Item Options 

You have an AIC-7899 adapter in your system.  Move 
the cursor to the bus:device:channel of the one for 
configuration and press <Enter>.  

Bus:Device:Channel 
01:06:A 
01:06:B 

<F5> - Toggle color/monochrome  

After selecting the bus, the following menu displays: 

Menu for each SCSI Channel 

Host Adapter Option Comment 

AIC-7899 at 
Bus:Device:Channel 
01:06:A (or 01:06:B) 

Configure/View Host 
Adapter Settings 

Press <Enter> to view the Configuration Menu. 

 SCSI Disk Utilities Press <Enter> to view the SCSI Disk Utilities 
Menu.  This menu allows you to format hard 
disks and/or verify disk media. 

When you are finished, press <Esc> and make your selection from the following menu: 

Exit Menu 

Feature Option Comment 

Exit Utility? Yes 
No 

When you finish configuring your SCSI devices, press <Esc>.  Then select 
Yes and press <Enter>.  When this message appears: 

Please press any key to reboot 

Press any key, and the server reboots. 

Running the Promise FastBuild Utility 
This utility is only found on the SCB2 ATA model only. 

The Promise ATA-100 host adapter is configured using the FastBuild†configuration utility that 
allows you to configure/view the settings of the host adapter and set RAID configurations. 
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When to Run the Promise FastBuild Utility 

Use the FastBuild utility to: 

• Define a RAID array 
• Delete a RAID array 
• Restore a RAID array 

Running the Promise FastBuild Utility 
1. When this message appears on the video monitor: 

<<<Press <Ctrl><F> to enter FastBuild (TM) Utility>>> 

2. Press <Ctrl+F> to run the utility. 

Direct Platform Control (DPC) Console 
Direct Platform Control (DPC) Console is part of Intel Server Control.  Direct Platform Control is a 
server management application that supports remote system management via LAN, or an 
RS-232 serial connection to the server COM2 port over a modem or a direct serial cable. The Direct 
Platform Control Console provides the ability for remote management of Intel servers via modem 
or LAN with a capability to run DOS-based programs. 

DPC console runs on a client workstation.  It communicates with a server by: 

• Accessing the server management capabilities of the on-board NIC 
• A Windows 2000 compatible modem. 
• An RS-232 connection to the server COM2 port. 

DPC Console is independent of the server operating system.  

Even when the server is off, you can use DPC Console to verify the state of a server or diagnose a 
problem with the server hardware.  DPC console features allows you to: 

• Establish connection to remote servers  
• Server Control: power on, power off, and reset operations 
• Retrieve and display entries in the System Event Log (SEL) 
• Retrieve and display Sensor Data Records (SDR) 
• Retrieve and display Field Replaceable Unit (FRU) information 
• Retrieve and display current Remote Sensor Access (RSA) information 
• Access a phonebook for remote connection management 
• Remote control of the service partition 
• File transfer from / to the server 
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DPC Console Modes of Operation 

There are three DPC console modes of operation: 

• EMP mode.  Access the DPC console features using the DPC console window menus and/or 
toolbar.  Active when a connection is established through the EMP port. 

• DPC over LAN mode.    Access the DPC console features using the DPC console window 
menus and/or toolbar.  Active when a connection is established through the LAN. 

• Re-direct mode.  Active when the server is running BIOS console redirection.  In this mode, the 
DPC console launches a separate window.  The window operates as an ANSI terminal and 
communicates with the server through the port.  Character-based commands you type in the 
DPC Console go directly to the server, and the DPC Console displays the text that you would 
normally see on the server console.   

To use this mode, you must configure the Console Redirection option of BIOS Setup for 
Re-direct mode.  Enabling Console Redirection requires that the Boot Time Diagnostics Screen 
be Enabled in BIOS Setup.  If the redirection window does not display information, the 
Console Redirection is either incorrectly configured or disabled, the EMP is disabled in BIOS 
Setup, or the server is in protected mode.  For DPC to function, the server must NOT be in 
graphics mode. 

If the DPC console fails to connect in EMP within 10 seconds and the server can operate in 
Re-direct mode, a prompt is displayed with the option to switch to Re-direct mode. 

• Service Partition mode.  Entered when the server reboots from the service partition and the 
DPC Console has successfully connected to the server through a modem.  This mode allows 
running of DOS-based programs that are stored on the service partition and transferring of files. 

Running the DPC Console 

For more information about setting up and running the DPC Console, see the document named 
"ENUDPCUG.pdf.”  This document is in the Manuals\SrvMgmt directory on the server software 
kit accompanying the SCB2 server board.   

Using the System Setup Utility 
The System Setup Utility (SSU) is located on the SCB2 System Resource CD-ROM shipped with 
the server board.  The SSU provides a graphical user interface (GUI) over an extensible framework 
for server configuration.  For the SCB2 systems, the SSU framework supports the following 
functions and capabilities:  

• Allows configuration of Sever Management options 
• Allows you to specify boot device order and system security options 
• Permits viewing and clearing of the system’s critical event log 
• Allows troubleshooting of the server when the OS is not operational 
• Allows you to view the system’s Sensor Data Records and Field Replaceable Unit information 
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What You Need to Do 

You can run the SSU directly from the SCB2 Server Software Kit CD-ROM by booting the server 
system to the CD and selecting “Utilities” or from a set of DOS diskettes. 

If you choose to run the SSU from a set of DOS diskettes, you must create the SSU diskettes from 
the SCB2 Resource CD-ROM by booting to the CD-ROM and selecting “Create Diskettes.”  
Alternatively, if you have a Windows based workstation, you can insert the CD into that system and 
create diskettes from the “Utilities” menu of the graphical user interface. 

If your diskette drive is disabled, or improperly configured, you must use BIOS Setup to enable it 
so that you can use the SSU.  If necessary, you can disable the drive after you exit the SSU.  
Information entered using the SSU overrides any entered using BIOS Setup. 

Running the SSU 

Running the ssu.bat file provided on the SSU media starts the SSU.  If the server boots directly 
from the SSU media, the ssu.bat file automatically runs.  If it boots from a different media, you can 
start the SSU manually or by another application.  When the SSU starts in the local execution mode 
(the default mode), the SSU accepts input from the keyboard and/or mouse.  The SSU presents a 
VGA based Graphical User Interface (GUI) on the primary monitor. 

The SSU runs from writable, non-writable, removable, and non-removable media.  If you run the 
SSU from non-writable media, you cannot save user preference settings (such as screen colors). 

The SSU supports the ROM-DOS® V6.22 operating system.  It may run on other 
ROM-DOS-compatible operating systems but they are not supported.  The SSU will not operate 
from a “DOS box” running under an operating system such as Windows. 

Starting the SSU 
SSU consists of a collection of task oriented modules plugged into a common framework called the 
Application Framework (AF).  The Application Framework provides a launching point for 
individual tasks and a location for setting customization information.  For full functionality, the 
SSU requires the availability of the AF.INI, AF.HLP, plus any .ADN files and their associated 
.HLP and .INI files. 

1. Turn on your video monitor and your system. 
2. There are two ways to start the SSU: 

a. After creating set of three SSU diskettes from the CD:  Insert the first SSU diskette in drive 
A, and press the reset button or <Ctrl+Alt+Del> to reboot your server from the diskette. 

b. Directly from the SCB2 Server Software Kit CD-ROM:  Insert the CD into your CD-ROM 
drive and press the reset button or <Ctrl-Alt-Del> to reboot.  When prompted to do so, 
press <F2> to enter BIOS Setup.  From the Boot Menu, select the Boot Device Priority 
option and then select CD-ROM as your primary boot device.  Save those settings and exit 
BIOS Setup.  The server will boot from the CD-ROM and display a menu of options.  
Follow the instructions in the menu to start the SSU. 

3. When the SSU title appears on the screen, press <Enter> to continue.  
4. The mouse driver loads if it is available; press <Enter> to continue.  
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5. This message appears:  
Please wait while the Application Framework loads.... 

6. When the main window of the SSU appears, you can customize your interface before 
continuing. (See Figure 24.) 

 

Figure 24.  System Setup Utility Main Window 

Customizing the SSU 

The SSU lets you customize your interface according to your preferences.  The AF sets these 
preferences and saves them in the AF.INI file so that they take effect the next time you start the 
SSU.  There are four user customizable settings: 

• Color - this button lets you change the default colors associated with different items on the 
screen with predefined color combinations.  The color changes are instantaneous. 

• Mode - this button lets you set the desired expertise level. 

 novice 

 intermediate 

 expert 

The expertise level determines which tasks are visible in the Available Tasks section and what 
actions each task performs.  For a new mode setting to take effect, you must exit the SSU and 
restart it.   

• Language - this button lets you change the strings in the SSU to strings of the appropriate 
language.  For a new language setting to take effect, you must exit the SSU and restart it. 

• Other - this button lets you change other miscellaneous options in the SSU.  The changes take 
effect immediately. 
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To change the interface default values: 

• Use the mouse to click on the proper button in the Preferences section of the SSU Main 
window. 
OR 

• Use the tab and arrow keys to highlight the desired button, and press the spacebar or <Enter>. 
OR 

• Access the menu bar with the mouse or hot keys (Alt + underlined letter). 

✏  NOTE 

If you run the SSU from non-writable media (like a CD-ROM), these 
preferences will be lost when you exit the SSU. 

Launching a Task 

It is possible to have many tasks open at the same time, although some tasks may require complete 
control to avoid possible conflicts.  The tasks achieve complete control by keeping the task as the 
center of operation until you close the task window. 

To launch a task: 

• In the SSU Main window, double click on the task name under Available Tasks to display the 
main window for the selected task. 
OR 

• Highlight the task name, and click on OK. 
OR 

• Use the tab and arrow keys to highlight the desired button, and press the spacebar or <Enter>. 

MultiBoot Options Add-in 

The Multiboot Add-in (MBA) provides an interface for selecting Initial Program Load (IPL) 
devices.  Using the MBA, the user can identify all IPL devices in the system and prioritize their 
boot order.  On power-up, the BIOS will sequentially attempt to boot from each device.   

Under this window, you can change the boot priority of a device. 

1. Select a device. 
2. Press the + button to move it up in the list.  Press the - button to move it down. 

Password Add-in  

The Password Add-in (PWA) provides security and password support options.  Within the PWA, 
the user can either set or modify the current system passwords or update any of the various security 
options available.   

To Set your Password 
1. Click on your password button. 
2. Enter the password in the first field. 
3. Confirm the password by entering it again in the second field. 
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To Change or Clear your Password 
1. Click on your password button. 
2. Enter the old password in the first field. 
3. Enter the new password in the second field (or leave blank to clear). 
4. Confirm the password by entering it again in the second field (or leave blank to clear). 

Admin Password Button 
The ‘Admin Password’ button allows the user to set or change the administrative password used by 
both the SSU and the system BIOS.  Note that this option is not available if both an administrative 
and a user password are set on the on the system and only the user password has been provided 
upon starting the SSU.  All changes to the admin password take place immediately. 

To Change or Clear the Administrator Password 
1. Click on the Administrator password button. 
2. Enter the old password in the first field. 
3. Enter the new password in the second field (or leave blank to clear). 
4. Confirm the password by entering it again in the second field (or leave blank to clear). 

User Password Button 
The ‘User Password’ button allows the user to set or change the user password used by both the 
SSU and the system BIOS.  All changes to the user password take place immediately. 

To Change or Clear the User Password 
1. Click on the User password button. 
2. Enter the old password in the first field. 
3. Enter the new password in the second field (or leave blank to clear). 
4. Confirm the password by entering it again in the second field (or leave blank to clear). 

Options Button  
The ‘Options’ button allows the user to set or change any of the various security options available 
on the system platform.  The window created by the ‘Options’ button includes ‘Save’, ‘Close’, and 
‘Help’ buttons.  

Under this window, you can set the other security options: 

• Hot Key—Set a key sequence that, when pressed, will drop the server into secure mode. 
• Lockout Timer—Set an interval that, if no activity takes place, it will drop the server into 

secure mode. 
• Secure Boot Mode—Force the server to boot directly into secure mode. 
• Video Blanking—Turn off the video when the server is in secure mode. 
• Floppy Write—Control access to the diskette drive while the server is in secure mode. 
• Reset/Power Switch Locking—Control the power and reset buttons while the server is in secure 

mode. 
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Close Button 
The ‘Close’ button exits the PWA and returns the user to the SSU. 

Help Button 
The ‘Help’ button invokes the SSU help subsystem. 

SEL Manager Add-in 

The System Event Log (SEL) Manager Add-In provides services to allow users to view the system 
event log stored on the server management storage device of a server.  The SEL Manager provides 
support for the user to perform the following: 

• Examine all system event log entries, stored in the non-volatile storage area of the server. 
• Examine system event log entries from a previously stored file. 
• Save the system event log entries to a file. 
• Clear the system event log entries from the non-volatile storage area. 

The SEL Manager has the following menus: 

File 
The File menu has the following options: 

• Open:  View data from a previously saved SEL file. 
• Save As:  Save the currently loaded SEL data to a file. 
• Exit:  Quits the SEL Viewer. 

SEL 
The SEL menu has the following options: 

• Properties:  Displays information about the SEL.  These fields are display only. 
• Clear SEL:  Clears the SEL data from the BMC. 
• All Events:  Displays the current SEL data from the BMC. 
• Reload:  Allows the user to re-load the SEL entries from the server. 

Help 
The Help menu has the following option: 

• Help Topics:  Displays the SEL Manager version information. 
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FRU Manager Add-in 

The FRU Manager is an add-in module, which allows users to view the FRU inventory areas on the 
server machine. The FRU Manager will have the functionality to display the FRU inventory areas 
in an interpreted, easy-to-understand textual form. The add-in allows users to do the following 
operations: 

1. Examine any of the individual FRU inventory areas. 
2. Examine FRU inventory areas from a previously stored file. 
3. Save the FRU inventory areas to a file in either text. 

The FRU Manager has the following menus: 

File 
The File menu has the following options: 

• Load:  View data from a previously saved FRU file. 
• Save:  Saves the currently loaded FRU data to a file. 
• Save As:  Saves the currently loaded FRU data to a file. 
• Exit:  Quits the FRU Viewer. 

View 
The View menu has the following options: 

• FRU Info:  Displays information about the FRU.  These fields are display only. 
• All FRU Areas:  Displays the current FRU data from the BMC. 
• By Device Type:  Brings up a popup menu that allows you to view only the data from a certain 

device type. 

Settings 
The Settings menu has the following options: 

• Display HEX/Verbose:  Toggles between the Hex/interpreted mode of displaying the 
FRU records. 

• Output Text/Binary:  Determines whether FRU data will be saved to the file (as under 
File - Save) in binary format or verbose format. 

Help 
The Help menu has the following option: 

• About:  Displays the FRU Viewer version information. 
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SDR Manager Add-in 

The Sensor Data Record (SDR) Manager Add-in component allows users to view sensor data 
records stored in the server management storage device of a server. 

The add-in allows users to perform the following operations: 

1. Examine all SDR’s through the BMC. 
2. Examine SDR’s from a previously stored file. 
3. Save all SDR’s to a file. 

File 
The File menu has the following options: 

• Open:  View data from a previously saved SDR file. 
• Save As:  Saves the currently loaded SDR data to a file. 
• Exit:  Quits the SDR Viewer. 

SDR 
The View menu has the following options: 

• Properties:  Displays information about the SDR.  These fields are display only. 
• Reload:  Allows the user to re-load the SDR data from the server. 

Help 
The Help menu has the following option: 

• Help Topics:  Displays the SDR Manager version information. 

System Update Add-In 

Clicking on the System Update Add-in task allows you to update nonvolatile storage on the server.  
The add-in allows you to do the following operations: 

• Determine the current revision of firmware on the server controllers. 
• Determine the current revision of BIOS on the server. 
• Update firmware revisions for controllers from external hex files. 
• Verify firmware code currently loaded versus an external hex file. 
• Update the BIOS from .bio or .uif files. 

The System Update Add-in has the following menus: 

File 
The File menu has the following options: 

• Load:  Select the file to use in the update. 
• Exit:  Quits the System Update Add-in. 
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Area 
The Area menu has the following options: 

• Update:  Use the loaded file to update the system.  If a file was not selected, the system will 
prompt you for one. 

• Verify:  Compares the contents of the nonvolatile storage with the selected file.  If a file was 
not selected, the system will prompt you for one.  You cannot verify the BIOS. 

Help 
The Help menu has the following options: 

• Help Topics:  Displays help information about the System Update Add-in. 
• About SU:  Displays System Update Add-in version information. 

Recovery Agent 
If the BMC firmware remote update fails, the server will reboot into the service partition and the 
recovery agent will attempt to finish the update.  The recovery agent is an executable file 
(recover.exe) that exists on the service partition. 

Configuration Save/Restore Add-In 
Clicking on the Configuration Save/Restore Add-in (CSR) allows you to save configuration 
information from various sources to a file.  The CSR saves information from the following sources: 

• CMOS 
• ESCD 
• PCI records in non-volatile storage 
• Non-volatile emergency management port (EMP), platform event paging (PEP), and Platform 

event filtering (PEF) settings 

Buttons 
• Save To File:  Displays a file dialog so you can choose a filename and location.  The CSR then 

tries to save any non-volatile configuration information it can to that file.  Data is saved from 
all sources.  There is no way to choose only certain pieces of configuration data to save.  The 
CSR also saves the platform type, BIOS version and firmware version information in the file.   

• Restore From File:  Displays a file dialog so you can choose a file containing configuration 
data to restore.  The CSR then reads the platform identification string from the file and 
compares it to a string retrieved from the BIOS on the server.  If the two do not match, an error 
message is displayed and the restore operation aborts.  If they do match, the add-in restores the 
configuration data to the server.  It prompts you to reboot the server for the new settings to 
take effect. 

✏  NOTE 

BIOS passwords are stored in the file.  Restoring a configuration can make 
passwords change on a server. 

• Close:  Closes the CSR main window. 
• Help:  Displays help information. 
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Platform Event Manager Add-in 

The Platform Event Manager (PEM) provides an interface for configuring Platform Event Paging 
(PEP), the Emergency Management Port (EMP), BMC LAN Configuration (LAN) and Platform 
Event Filtering (PEF). 

Platform Event Manager Window 
The PEM presents a main window to the user and supports several features (see Figure 25).  These 
features appear in additional detail in the following sections.  Note that each option included on the 
main window supports an accelerator key.  An underlined letter in the text listing the option in 
VGA mode indicates accelerator keys.  In text mode, accelerator key letters appear highlighted 
rather than underlined. 

 

Figure 25.  Platform Event Manager Main Window 

Buttons 
• Configure PEP:  Opens a new dialog that allows you to configure the Platform Event Paging 

features.   
• Configure LAN:  Opens a new dialog that allows you to configure the 

BMC LAN-Configuration features. 
• Configure EMP:  Opens a new dialog that allows you to configure the Emergency 

Management Port features.   
• Close:  Exits the Platform Event Manager and returns you to the AF. 
• Help:  Displays help information. 
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Platform Event Paging Dialog 
This dialog allows you to configure the Platform Event Paging features.  (See Figure 26.) 

 

Figure 26.  Platform Event Paging Dialog 

File  

The File menu has the following options: 

• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Platform Event Paging dialog without saving changes.  If 

changes have been made, you will be prompted to save changes before closing. 

Options 

The Options menu has the following options: 

• Enable PEP:  Allows you to enable or disable the PEP feature entirely.  A check will appear 
next to the menu item when PEP is enabled. 

• Send Alert:  Allows you to immediately send a test page with the configuration currently 
shown on the screen. 

• Configure Event Actions:  Launches the Platform Event Paging Actions Dialog (see Figure 28 
on page 71) to allow you to configure event actions. 

Help Topics  

The Help Topics menu has the following options: 

• Help Topics:  Displays help information. 

Enable PEP Checkbox 

Enable or disable the PEP feature entirely. 

Blackout Period in Minutes 

Enter the time, in minutes, between successive pages.  The valid range is [0 – 255] where 0 disables 
the blackout period. 
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Paging String 

Enter the paging string that contains both the paging service number and the characters that are sent 
once the connection has been made.  The length of the paging string is determined at run-time from 
firmware.  You will be notified if the string is truncated.  The screen will show the string that was 
saved after a save operation is done. 

Buttons 
• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Platform Event Paging dialog without saving changes.  If 

changes have been made, you will be prompted to save changes before closing. 
• Help:  Displays help information. 

BMC LAN-Configuration Dialog 
This dialog allows you to configure the BMC LAN-Configuration features.  (See Figure 27.) 

 

Figure 27.  BMC LAN-Configuration Dialog 
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File  

The File menu has the following options: 

• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the BMC LAN-Configuration dialog without saving changes.  If 

changes have been made, you will be prompted to save changes before closing. 

Options Menu 

The Options menu has the following options: 

• Enable LAN Alerts:  Allows you to enable or disable the BMC LAN-Alerting features 
entirely.  A check will appear next to the menu item when it is enabled. 

• Clear LAN Password:  Allows you to clear the currently saved LAN password.  This takes 
effect immediately.  This option is only available if the LAN password is set. 

• Configure Event Actions:  Launches the BMC LAN-Alerting Actions Dialog to allow you to 
configure event actions. 

Help Topics Menu 

The Help Topics menu has the following options: 

• Help Topics:  Displays help information. 

Enable LAN Alerts Checkbox 

Enables or disables BMC LAN-Alerting. 

Enter New Password  

Allows you to enter a LAN password.  The valid range of characters includes ASCII values 32-126.  
The password must be from 1-16 characters long. 

Verify New Password  

Enter the same password as above. 

LAN Access Mode  

Allows you to set the remote access mode desired.  In Enabled mode, a remote system can initiate a 
LAN session regardless of system state or health.  In Disabled mode, remote LAN sessions cannot 
be initiated.  In Restricted mode, control operations cannot be performed such as power down, front 
panel NMI, and reset. 

SNMP Community String  

Can be configured for the community field in the Header section of the SNMP trap sent for a 
LAN alert.  The default string is ‘public’.  The string must be from 5-16 characters long. 
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IP Configuration 

• DHCP:  Enables the dynamic host configuration protocol to allow the server to automatically 
assign the host IP address, router IP address and subnet mask.  The host IP address, router 
IP address and subnet mask will not be saved if this radio button is checked.   

• Static:  Allows you to set the server host IP address, router IP address and subnet mask.  The 
host IP address, router IP address and subnet mask will be saved if this radio button is checked.  
The values saved will take effect immediately. 

Host IP Address  

Enter the Logical or Internet Address of the host.  The Host IP Address will only be saved when 
DHCP is disabled.  The IP is entered as a dotted IP, (e.g., 192.168.0.2). 

Gateway IP Address  

Enter the Logical or Internet Address of the router.  The Gateway IP Address will only be saved 
when DHCP is disabled.  The IP is entered as a dotted IP, (e.g., 192.168.0.2). 

Subnet Mask  

Enter the logical or Internet address of the host’s subnet.  The server uses this to decide if the alert 
destination is in the local subnet or in another subnet relative to the server.  The Subnet Mask will 
only be saved when DHCP is disabled.  The IP is entered as a dotted IP, e.g., 192.168.0.2 

Alert IP Address  

Enter the logical or Internet address of the Alert-Destination.  In case of single node destination, 
this is the unicast or specific IP address.  This is the IP Subnet address if the alert needs to be 
broadcast within a particular subnet.  The Alert IP Address is always saved.  The IP is entered as a 
dotted IP, e.g., 192.168.0.2 

Buttons 

• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the BMC LAN-Alert dialog without saving changes.  If changes 

have been made, you will be prompted to save changes before closing. 
• Help:  Displays help information. 
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Platform Event Action Dialogs 
These similar dialogs allow you to configure the Platform Event Action features for PEP and BLA 
(See Figure 28).  If an event is in the enabled listbox, it will generate the appropriate action when it 
occurs.  If an event is in the disabled listbox, it will not generate an action when it occurs.  Enable 
global action for events to generate actions.  This global flag is in the PEP or BLA dialogs as 
‘Enable PEP’ or ‘Enable BLA’ checkboxes. 

 

Figure 28.  Platform Event Action Dialogs 

File Menu 

The File menu has the following options: 

• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Platform Event Action dialog without saving changes.  If you 

have made changes, you will be prompted to save changes before closing. 

Help Topics Menu 

The Help Topics menu has the following options: 

• Help Topics:  Displays help information. 

Enabled Listbox 

Contains the active events. 

Disabled Listbox 

Contains the events that are not active. 
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Buttons 
• >>:  Moves all the events from the enabled listbox to the disabled listbox. 
• >:  Moves the selected event from the enabled listbox to the disabled listbox. 
• <:  Moves the selected event from the disabled listbox to enabled the listbox. 
• <<:  Moves all the events from the disabled listbox to the enabled listbox. 
• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Platform Event Action dialog without saving changes.  If you 

have made changes, you will be prompted to save changes before closing. 
• Help:  Displays help information. 

Emergency Management Port Dialog 
This dialog allows you to configure the Emergency Management Port features.  (See Figure 29.) 

 

Figure 29.  Emergency Management Port Dialog 

File 

The File menu has the following options: 

• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Emergency Management Port dialog without saving changes.  

If you have made changes, you will be prompted to save changes before closing. 

Options 

The Options menu has the following options: 

• Clear EMP Password:  Allows you to clear the currently saved EMP password.  This takes 
effect immediately.  This option is only available if the EMP password is set. 
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Help Topics 

The Help Topics menu has the following options: 

• Help Topics:  Displays help information. 

Enter New Password  

Enter an EMP password.  The valid range of characters includes ASCII values 32-126.  The 
password must be from 1-16 characters long. 

Verify New Password  

Enter the same password as above. 

ESC Sequence 

The ESC Sequence string is sent to the modem before sending a command string to the modem.  
The length of the paging string is determined at run-time from firmware.  You will be notified if the 
string is truncated.  The string that has been saved is the one that will be shown in the edit box. 

Hangup String 

The Hangup Line string is sent to the modem whenever the EMP wants to terminate the session.  
The EMP automatically sends an <ENTER> character after this string.  The length of the paging 
string is determined at run-time from firmware.  You will be notified if the string is truncated.  The 
string that has been saved is the one that will be shown in the edit box. 

Modem Init String 

The Modem Init String string is transmitted every time the EMP initializes.  The length of the 
paging string is determined at run-time from firmware.  You will be notified if the string is 
truncated.  The string that has been saved is the one that will be shown in the edit box. 

System Phone Number 

Enter the system telephone number.  This can be retrieved and reported via in-band management 
connections. 

Access Mode  

In Pre-boot Only the EMP is automatically activated when the system is powered-down or hard 
reset.  In Always Active the EMP is active when the system is powered-down or hard reset.  In 
Disabled the EMP powers-up deactivated and is not automatically activated by BIOS, power-down 
or hard resets. 

Restricted Mode Access  

When restricted mode is enabled control operations that could disable or alter a running system via 
the EMP are disabled. 

Connection Mode  

Direct connect mode is for applications that connect the port directly to another computer system, 
while Modem Mode is for applications where the port is connected to an external modem. 
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Buttons 
• Save:  Allows you to save the configuration immediately. 
• Close:  Allows you to close the Emergency Management Port dialog without saving changes.  

If you have made changes, you will be prompted to save changes before closing. 
• Help:  Displays help information. 

Exiting the SSU 

Exiting the SSU causes all windows to close. 

1. Exit the SSU by opening the menu bar item File in the SSU Main window. 
2. Click on Exit or Highlight Exit, and press <Enter>. 

Platform Event Paging 
With Platform Event Paging (PEP), your server can automatically dial up a paging service and page 
you when a server management related event occurs.  Platform events include temperature 
out-of-range, voltage out-of-range, chassis intrusion, and fan failure. 

If PEP is enabled and the BMC receives or detects a new event, it automatically sends a page.  It 
can send a page if the processors are down or if the system software is unavailable. 

PEP needs an external modem connected to the server’s EMP (Emergency Management Port) serial 
connection.  This is typically the COM2 serial connector. 

Using Platform Event Paging 
1. From the SSU main window, launch the Platform Event Manager Add-in (PEM).  For more 

information, see page 66. 
2. In the PEM dialog box, click the Configure PEP button. 
3. In the PEP dialog box, check the Enable PEP to box. 
4. Enter your page string in the Paging String field.  This consists of the following: 

• The attention command for your modem (generally ATDT). 

• The number of your paging service, several commas (each comma is a 1-second pause). 

• The number/message you wish to appear on your pager. 

• The hang up command for your modem (generally ATH). 

You will need to experiment with the timing to ensure you are paged properly.  Select Send 
Alert form the Options menu to generate a test page. 

5. Set the time between pages with the Blackout Period In Minutes field.  If you want to be paged 
every five minutes, set it to 5.  The range is from 0 to 10 minutes. 

6. If you wish to filter events so that only certain events will originate a page, select Configure 
Event Actions from the Options menu.  This will bring up the Platform Event Action dialog. 

7. Save all the changes made by clicking on the Save button.  Saving writes your current 
configuration to nonvolatile storage where it will be available to the system after every reboot.   
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Software Updates 
Your system comes with preinstalled system BIOS and BMC firmware.  When necessary, updates 
will be available for download from the Intel support website at:   

http://support.intel.com/support/motherboards/server/SCB2 

The updates are available in two forms:  

• A software update package (SUP) containing all three updates 
• Individual files, one for each update, that are manually executed 

With either form, bootable diskettes must be created. 

Creating a Bootable Diskette 

Each update diskette created must be made bootable with ROM-DOS Ver. 6.22 or MS-DOS 
Ver. 6.22. 

✏  NOTE 

It is recommended that the target system be booted with the Resource CD 
that accompanied the product.  However, the process for making the diskettes 
is the same for all the compatible versions of DOS.  ROM-DOS Ver. 6.22 is 
included on the Resource CD. 

 

1. Insert and boot to the Resource CD. 
2. Exit from the menu to a DOS prompt. 
3. Insert a diskette into the floppy drive. 
4. At the DOS prompt, for an unformatted diskette, type: 

format a:/s 

or, for a formatted diskette, type: 
sys a: 

4. Press <Enter>. 

Software Update Package 
A Software Update Package (SUP) contains all the necessary files to perform BIOS, BMC, 
FRU/SDR, or other software updates. 

Preparation 

Before proceeding, review the release notes. 

1. Download the software update. 
2. Print, review, and follow the instruction.rtf file (it supercedes any other instructions) 
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3. Label three blank floppy disks as follows: 
• Disk 1 - SCB2 BIOS update diskette 
• Disk 2 – SCB2 BMC update diskette 
• Disk 3 – SCB2 FRU/SDR update diskette 

4. Make the diskettes DOS bootable. 
 

5. Record the current BIOS settings. 
a. Boot the computer and press <F2> when you see the splash screen. 
b. Write down the current settings in the BIOS Setup program. 

✏  NOTE 
Be sure to record the current custom BIOS settings. They will be cleared 
and reset to their default values during the BIOS update portion of the 
operation.  You will need these settings to configure your computer at 
the end of the update procedure.  To record the current custom settings, 
boot the computer and press <F2> when you see the splash screen. Write 
down the current custom settings in the BIOS Setup program 

Extraction 

Double click the executable file you downloaded.  Read the License Agreement, select "I Agree" to 
accept the terms and conditions or select "Cancel" to cancel the installation. 

During the extraction process, you will be prompted to insert each of the three labeled diskettes.  
Follow the prompts until the process is completed.  When completed, you will have three diskettes 
that can be used to update the BIOS, the BMC firmware, and the FRU/SDR records.   

Updating 

✏  NOTE 

Do not turn off the system during the update process. 
 

Apply the updates in order by booting from each floppy diskette beginning with Disk 1. 

1. Disk 1 - SCB2 BIOS update—Choose option 1 to update the system BIOS.  The system will 
automatically reboot following completion. 

2. Disk 2 – SCB2 BMC update—Automatic, no questions are asked.  The system will notify you 
that it is going to reboot. 

3. Disk 3 – SCB2 FRU/SDR update—Prompts you to choose the chassis type.  You can choose to 
update the chassis information; you will be prompted for the Serial Number, Part Number, and 
Asset Tag. 

Following the update process, the system will automatically reboot.  Upon completion, it may be 
necessary to enter BIOS setup and reconfigure the setting values. 
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Individual Updates 

BIOS Upgrade Description 

Preparing for the Upgrade 
Before upgrading the BIOS, prepare for the upgrade by recording the current custom BIOS settings, 
and obtaining the upgrade utility.  

Obtaining a BIOS Update 

You can download the most current version of the BIOS from the Intel support website at:  

http://support.intel.com/support/motherboards/server/scb2 

✏  NOTE 

Print and  review the release notes and instructions distributed with the 
upgrade utility before attempting a BIOS upgrade. 

This upgrade utility allows you to upgrade the BIOS in flash memory.  The 
following steps explain how to upgrade the BIOS. 

Creating the BIOS Upgrade Diskette 
The BIOS upgrade file is a compressed self-extracting archive that contains the files you need to 
upgrade the BIOS. 

1. Copy the BIOS upgrade file to a temporary directory on the hard disk. 
2. From the C:\ prompt, change to the temporary directory. 
3. To extract the file, type the name of the BIOS upgrade file, for example: 

10006BI1.EXE 

4. Press <Enter>.  The extracted file contains the following files: 

LICENSE.TXT 
INSTALL.TXT 
BIOS.EXE 

5. Read the LICENSE.TXT file, this contains the software license agreement, and the 
INSTALL.TXT file.  It contains the instructions for the BIOS upgrade.  

6. Insert the bootable diskette into drive A. 
7. To extract the BIOS.EXE file to the diskette, change to the temporary directory that holds the 

BIOS.EXE file and type: 
BIOS A: 

8. Press <Enter>. 
9. The diskette now holds the BIOS upgrade and recovery files. 
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Upgrading the BIOS 
1. Insert the diskette holding the BIOS upgrade and recovery files into drive A and boot the 

computer.  
2. Press <1> and <Enter>. 
3. When the utility finishes updating the BIOS, remove the diskette from the drive A, reboot the 

system, clear CMOS 
4. Press F2 to enter Setup and reconfigure any custom settings. 
5. If you need to change the BIOS settings, press <F2> while the splash screen displays to enter 

the Setup program. 

Recovering the BIOS 
It is unlikely that anything will interrupt the BIOS upgrade; however, an interruption could damage 
the BIOS.  The following steps explain how to recover the BIOS if an upgrade fails.  The following 
procedure uses recovery mode for the Setup program. 

✏  NOTE 

Because of the small amount of code available in the non-erasable boot block 
area, there is no video support.  You will not see anything on the screen 
during the procedure.  Monitor the procedure by listening to the speaker and 
looking at the floppy drive LED.   

1. Turn off all connected peripherals, turn off system power, and disconnect the AC power cord. 
2. Remove the access cover and expose the server board.  For instructions, see the product guide 

accompanying your system. 
3. Locate the server board jumpers.  (See Figure 30 on page 91.) 
4. Move the Recovery Boot (RCVRY BOOT) jumper from its normal position to the BIOS 

recovery position (see Figure 30 and Table 10 on page 91). 
5. Reinstall the access cover and connect the power cord. 
6. Insert the diskette holding the BIOS upgrade and recovery files into drive A.  
7. Turn on system power and listen to the speaker:   

• Two beeps indicate successful BIOS recovery—Go to the next step. 

• A series of continuous beeps indicates failed BIOS recovery—Return to Step 1 and repeat 
the recovery process. 

8. Turn off system power and disconnect all AC power cords. 
9. Remove the access cover. 
10. Move the Recovery Boot jumper back to its normal position. 
11. Reinstall the access cover. 
12. Connect all AC power cords and turn on system power.  

Changing the BIOS Language 
You can use the BIOS upgrade utility to change the language BIOS displays.  Use a bootable 
diskette containing the Intel flash utility and language files.  See "Using BIOS Setup" on page 43. 
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Firmware Update Utility Description 

The Firmware Update Utility is a DOS-based program used to update the BMCs firmware code.  
You need to run the utility only if new firmware code is necessary. 

Running the Firmware Update Utility 
Review the release notes before proceeding. 

1. Create a DOS-bootable diskette.  The version of DOS must be 6.0 or higher. 
2. Place the firmware update utility (FWUPDATE.EXE) and the *.hex file on the diskette.  Make 

a note of the *.hex file name, because you will need it later. 
3. Insert the diskette into the drive and boot to it. 
4. At the DOS prompt, run the executable file (FWUPDATE.EXE).   
5. The utility displays a menu screen.  Select “Upload Flash.” 
6. The utility asks for a file name.  Enter the name of the *.hex file. 
7. The program will load the file and then ask if it should upload boot code.  Press “N” to 

continue unless otherwise directed by the release notes or an Intel support professional. 
8. The program next asks if it should upload operational code.  Press “Y” to continue.  The 

process of uploading operational code takes a few minutes. 
9. Once the operational code updates and verifies, press any key to continue.  Then press <ESC> 

to exit the program. 
10. Shut the system down and remove any diskettes in the system. 
11. Disconnect the AC power cord from the system and wait 60 seconds. 
12. Reconnect the AC power cord and power up the system. 

FRU/SDR Load Utility Description 

The Field Replacement Unit (FRU) and Sensor Data Record (SDR) load utility is a DOS-based 
program used to update the server management subsystem’s product level FRU and SDR 
nonvolatile storage components (EEPROMs).  The utility: 

• Discovers the product configuration based on instructions in a master configuration file 
• Displays the FRU information 
• Updates the EEPROM associated with the Baseboard Management Controller (BMC) that 

holds the SDR and FRU area 
• Generically handles FRU devices that might not be associated with the BMC 

What You Need to Do 
Either run the utility directly from the Resource CD or from diskettes created from the CD. 

If you run the FRU/SDR Load Utility from a diskette, copy the utility from the CD.  Follow the 
instructions in the included README.TXT file. 

If the diskette drive is disabled, or improperly configured, use BIOS Setup to enable it.  If 
necessary, disable the drive after you are done with the FRU/SDR utility. 
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How You Use the FRU/SDR Load Utility 
The utility: 

• Is compatible with ROM-DOS Ver. 6.22, MS-DOS Ver. 6.22 (and later versions), Windows 95 
DOS, and Windows 98 DOS 

• Accepts CFG, SDR, and FRU load files (the executable file for the utility is FRU/SDR.exe) 
• Requires the following supporting files: 

 One or more .fru files describing the system’s field replaceable units 

 A .cfg file describing the system configuration 

 An .sdr file describing the sensors in the system 

Command Line Format 

If you are not performing an automated update using a Software Update Package (SUP), the basic 
command line format is: 

FRU/SDR [-?] [-h] [-d {fru, sdr}] [-cfg filename.cfg] [-fru filename.fru] 

Table 9. Command Line Format 

Command Description 

-? or -h Displays usage information. 

-d {fru, sdr} Displays requested area only. 

-cfg filename.cfg Uses custom CFG file. 

-p Pause between blocks of data. 

Parsing the Command Line 

The FRU/SDR load utility allows only one command line function at a time.  A command line 
function can consist of two parameters.  Example:  -cfg filename.cfg.  Invalid parameters cause an 
error message and exit the program.  You can use either a slash (/) or a minus sign (-) to specify 
command line options.  Use the -p and flags with any of the other options. 

Displaying a Given Area  

When the utility is run with the -d FRU or -d SDR command line flag, information about each area 
is read from memory and printed on the screen.  Each area represents one sensor for each 
instrumented device in the server.  If the given display function fails because of an inability to parse 
the data present or a hardware failure, the utility displays an error message and exits. 

Using Specified CFG File 

Run the utility with the command line parameter of -cfg filename.cfg.  The filename can be any 
DOS-accepted, eight-character filename string.  The utility loads the specified CFG file and uses 
the entries in that file to probe the hardware and to select the proper SDRs to load into nonvolatile 
storage.   

Displaying Utility Title and Version 

The utility displays its title: 

FRU & SDR Load Utility, Version Y.Y, Revision X.XX where Y.Y is the version number and 
X.XX is the revision number for the utility. 
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Configuration File 

The configuration file is in ASCII text.  The utility executes commands formed by the strings 
present in the configuration file.  These commands cause the utility to run tasks needed to load the 
proper SDRs into the nonvolatile storage of the BMC and possibly generic FRU devices.  Some of 
the commands may be interactive and require you to make a choice. 

Prompting for Product Level FRU Information 

With a configuration file, the utility might prompt you for FRU information. 

Filtering Records from the SDR File 

The MASTER.SDR file has all the possible SDRs for the system.  You might need to filter these 
records based on the current product configuration.  The configuration file directs the filtering of 
the SDRs. 

Updating the SDR Nonvolatile Storage Area 

After the utility validates the header area of the supplied SDR file, it updates the SDR repository 
area.  Before programming, the utility clears the SDR repository area.  The utility filters all tagged 
SDRs depending on the product configuration set in the configuration file.  Untagged SDRs come 
automatically programmed.  The utility also copies all written SDRs to the SDR.TMP file; it 
contains an image of what was loaded.  The TMP file is also useful for debugging the server. 

Updating FRU Nonvolatile Storage Area 

After the configuration is determined, the utility updates the FRU nonvolatile storage area.  First, it 
verifies the common header area and checksum from the specified FRU file.  The internal use area 
reads out of the specified .FRU file then programmed into the nonvolatile storage.  The chassis area 
reads out of the specified .FRU file.  Finally, it reads the product area out of the specified FRU file, 
then the area programs into the FRU nonvolatile storage.  All areas write to the FRU.TMP file. 
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5 Solving Problems 

This chapter helps you identify and solve problems that might occur while you are using the 
system.  For additional assistance and the problem report form, refer to the SCB2 Trouble Shooting 
Guide on the Support website. 

Resetting the System 
To do this: Press: 

Soft boot reset, which clears system memory and reloads the operating system. <Ctrl+Alt+Del> 

Clear system memory, restart POST, and reload the operating system. Reset button 

Cold boot reset.  Turn the system power off and then on.  This clears system memory, 
restarts POST, reloads the operating system, and halts power to all peripherals. 

Power off/on 

Initial System Startup 
Problems that occur at initial system startup are usually caused by incorrect installation or 
configuration.  Hardware failure is a less frequent cause. 

Checklist 
��Are all cables correctly connected and secured? 
��Are the processors or processor termination board fully seated in their slots on the 

server board? 
��Are all add-in PCI boards fully seated in their slots on the server board? 
��Are all jumper settings on the server board correct? 
��Are all jumper and switch settings on add-in boards and peripheral devices correct?  To check 

these settings, refer to the manufacturer’s documentation that comes with them.  If applicable, 
ensure that there are no conflicts—for example, two add-in boards sharing the same interrupt. 

��Are all DIMMs installed correctly? 
��Are all peripheral devices installed correctly? 
��If the system has a hard disk drive, is it properly formatted or configured? 
��Are all device drivers properly installed? 
��Are the configuration settings made in BIOS Setup correct? 
��Is the operating system properly loaded?  Refer to the operating system documentation. 
��Did you press the system power on/off switch on the front panel to turn the server on (power on 

light should be lit)? 
��Is the system power cord properly connected to the system and plugged into a 

NEMA 5-15R outlet for 100-120 V∼  or a NEMA 6-15R outlet for 200-240 V∼ ? 
��Is AC power available at the wall outlet? 
��Are all integrated components from the tested components lists? Check the tested memory, and  

chassis lists, as well as the supported hardware and operating system list on the Intel Customer 
Support website. 
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Running New Application Software 
Problems that occur when you run new application software are usually related to the software.  
Faulty equipment is much less likely, especially if other software runs correctly. 

Checklist 
��Does the system meet the minimum hardware requirements for the software?  See the software 

documentation. 
��Is the software an authorized copy?  If not, get one; unauthorized copies often do not work. 
��If you are running the software from a diskette, is it a good copy? 
��If you are running the software from a CD-ROM disk, is the disk scratched or dirty? 
��If you are running the software from a hard disk drive, is the software correctly installed?  Were 

all necessary procedures followed and files installed? 
��Are the correct device drivers installed? 
��Is the software correctly configured for the system? 
��Are you using the software correctly? 

If the problems persist, contact the software vendor’s customer service representative. 

After the System Has Been Running Correctly 
Problems that occur after the system hardware and software have been running correctly often 
indicate equipment failure.  Many situations that are easy to correct, however, can also cause such 
problems. 

Checklist 
��If you are running the software from a diskette, try a new copy of the software. 
��If you are running the software from a CD-ROM disk, try a different disk to see if the problem 

occurs on all disks. 
��If you are running the software from a hard disk drive, try running it from a diskette.  If the 

software runs correctly, there may be a problem with the copy on the hard disk drive.  Reinstall 
the software on the hard disk, and try running it again.  Make sure all necessary files are 
installed. 

��If the problems are intermittent, there may be a loose cable, dirt in the keyboard (if keyboard 
input is incorrect), a marginal power supply, or other random component failures. 

��If you suspect that a transient voltage spike, power outage, or brownout might have occurred, 
reload the software and try running it again.  (Symptoms of voltage spikes include a flickering 
video display, unexpected system reboots, and the system not responding to user commands.) 

✏  NOTE 
Random errors in data files:  If you are getting random errors in your data 
files, they may be getting corrupted by voltage spikes on your power line.  If 
you are experiencing any of the above symptoms that might indicate voltage 
spikes on the power line, you may want to install a surge suppressor between 
the power outlet and the system power cord. 
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More Problem Solving Procedures 
This section provides a more detailed approach to identifying a problem and locating its source. 

Preparing the System for Diagnostic Testing 

 CAUTION 
Turn off devices before disconnecting cables:  Before disconnecting any 
peripheral cables from the system, turn off the system and any external 
peripheral devices.  Failure to do so can cause permanent damage to the 
system and/or the peripheral devices. 

1. Turn off the system and all external peripheral devices.  Disconnect all of them from the 
system, except the keyboard and video monitor. 

2. Make sure the system power cord is plugged into a properly grounded AC outlet. 
3. Make sure your video display monitor and keyboard are correctly connected to the system.  

Turn on the video monitor.  Set its brightness and contrast controls to at least two thirds of their 
maximum ranges (see the documentation supplied with your video display monitor). 

4. If the operating system normally loads from the hard disk drive, make sure there is no diskette 
in drive A.  Otherwise, place a diskette containing the operating system files in drive A. 

5. Turn on the system.  If the power LED does not light, see “Power Light Does Not Light” on 
page 86. 

6. If errors are encountered, power off the system and remove all add-in cards. 

Monitoring POST 

See “Power-On Self-Test (POST)” on page 43. 

Verifying Proper Operation of Key System Lights 

As POST determines the system configuration, it tests for the presence of each mass storage device 
installed in the system.  As each device is checked, its activity light should turn on briefly.  Check 
for the following: 

��Does the diskette drive activity light turn on briefly?  If not, see “Diskette Drive Activity Light 
Does Not Light” on page 88. 

��If a second diskette drive is installed, does its activity light turn on briefly?  If not, see “Diskette 
Drive Activity Light Does Not Light” on page 88. 

Confirming Loading of the Operating System 

Once the system boots up, the operating system prompt appears on the screen.  The prompt varies 
according to the operating system.  If the operating system prompt does not appear, see “Initial 
System Startup” on page 83. 
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Specific Problems and Corrective Actions 
This section provides possible solutions for these specific problems: 

• Power light does not light. 
• There is no beep or an incorrect beep pattern. 
• No characters appear on screen. 
• Characters on the screen appear distorted or incorrect. 
• System cooling fans do not rotate. 
• Diskette drive activity light does not light. 
• CD-ROM drive activity light does not light. 
• There are problems with application software. 
• The bootable CD-ROM is not detected. 

Try the solutions in the order given.  If you cannot correct the problem, contact your service 
representative or authorized dealer for help. 

Power Light Does Not Light 

Check the following: 

��Is the system operating normally?  If so, the power LED is probably defective or the cable from 
the front panel to the server board is loose. 

��Are there other problems with the system?  If so, check the items listed under “System Cooling 
Fans Do Not Rotate Properly.” 

If all items are correct and problems persist, contact your service representative or authorized dealer 
for help. 

No Characters Appear on Screen 

Check the following: 

��Is the keyboard functioning?  Check to see that the “Num Lock” light is functioning. 

��Is the video monitor plugged in and turned on? 

��Are the brightness and contrast controls on the video monitor properly adjusted? 

��Are the video monitor switch settings correct? 

��Is the video monitor signal cable properly installed? 

��Is the onboard video controller enabled? 
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If you are using an add-in video controller board, do the following: 

1. Verify that the video controller board is fully seated in the server board connector. 
2. Reboot the system for changes to take effect. 
3. If there are still no characters on the screen after you reboot the system and POST emits a beep 

code, write down the beep code you hear.  This information is useful for your service 
representative. 

4. If you do not receive a beep code and characters do not appear, the video display monitor or 
video controller may have failed.  Contact your service representative or authorized dealer 
for help. 

Characters Are Distorted or Incorrect 

Check the following: 

��Are the brightness and contrast controls properly adjusted on the video monitor?  See the 
manufacturer’s documentation. 

��Are the video monitor signal and power cables properly installed? 

If the problem persists, the video monitor may be faulty or it may be the incorrect type.  Contact 
your service representative or authorized dealer for help. 

System Cooling Fans Do Not Rotate Properly 

If the system cooling fans are not operating properly, system components could be damaged. 

Check the following: 

��Is AC power available at the wall outlet? 

��Is the system power cord properly connected to the system and the wall outlet? 

��Did you press the power button? 

��Is the power on light lit? 

��Have any of the fan motors stopped (use the server management subsystem to check the 
fan status)? 

��Are the fan power connectors properly connected to the server board? 

��Is the cable from the front panel board connected to the server board? 

��Are the power supply cables properly connected to the server board? 

��Are there any shorted wires caused by pinched cables or power connector plugs forced into 
power connector sockets the wrong way? 

If the switches and connections are correct and AC power is available at the wall outlet, contact 
your service representative or authorized dealer for help. 



88   Intel Server Board SCB2 Product Guide 

Diskette Drive Activity Light Does Not Light 

Check the following: 

��Are the diskette drive power and signal cables properly installed? 

��Are all relevant switches and jumpers on the diskette drive set correctly? 

��Is the diskette drive properly configured? 

��Is the diskette drive activity light always on?  If so, the signal cable may be plugged in 
incorrectly. 

If you are using the onboard diskette controller, use the Setup Utility to make sure that “Onboard 
Floppy” is set to “Enabled.”  If you are using an add-in diskette controller, make sure that 
“Onboard Floppy” is set to “Disabled.”   

If the problem persists, there may be a problem with the diskette drive, server board, or drive signal 
cable.  Contact your service representative or authorized dealer for help. 

CD-ROM Drive Activity Light Does Not Light 

Check the following: 

��Are the power and signal cables to the CD-ROM drive properly installed? 

��Are all relevant switches and jumpers on the drive set correctly? 

��Is the drive properly configured? 

��Is the onboard IDE controller enabled? 

Cannot Connect to a Server 
��Make sure you are using the drivers that are shipped on the system Configuration Software CD 

for the onboard network controller. 

��Make sure the driver is loaded and the protocols are bound. 

��Make sure the network cable is securely attached to the connector at the system back panel.  If 
the cable is attached but the problem persists, try a different cable. 

��Make sure the hub port is configured for the same duplex mode as the network controller. 

��Check with your LAN administrator about the correct networking software that needs to be 
installed. 

��If you are directly connecting two servers (no hub), you will need a crossover cable (see your 
hub documentation for more information on crossover cables). 

��Check the network controller LEDs that are visible through an opening at the system 
back panel. 
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Problems with Network 

The server hangs when the drivers are loaded: 

��Change the PCI BIOS interrupt settings.  Try the “PCI Installation Tips” below. 

Diagnostics pass, but the connection fails: 

��Make sure the network cable is securely attached. 

��Make sure you specify the correct frame type in your NET.CFG file. 

The Activity LED doesn’t light: 

Make sure the network hub has power. 

The controller stopped working when an add-in adapter was installed: 

��Make sure the cable is connected to the port from the onboard network controller. 

��Make sure your PCI BIOS is current. 

��Make sure the other adapter supports shared interrupts.  Also, make sure your operating system 
supports shared interrupts; OS/2† does not. 

��Try reseating the add in adapter. 

The add-in adapter stopped working without apparent cause: 

��Try reseating the adapter first; then try a different slot if necessary. 

��The network driver files may be corrupt or deleted.  Delete and then reinstall the drivers. 

��Run the diagnostics. 
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Problems with Application Software 
If you have problems with application software, do the following: 

��Verify that the software is properly configured for the system.  See the software installation and 
operation documentation for instructions on setting up and using the software. 

��Try a different copy of the software to see if the problem is with the copy you are using. 

��Make sure all cables are installed correctly. 

��Verify that the server board jumpers are set correctly.  See Chapter 5. 

��If other software runs correctly on the system, contact your vendor about the failing software. 

If the problem persists, contact the software vendor’s customer service representative for help. 

Bootable CD-ROM Is Not Detected 
Check the following: 

��Is the BIOS set to allow the CD-ROM to be the first bootable device? 

��Check cable connections. 

��Verify CD is bootable in another known good CD-ROM drive.  (Especially if the CD 
is a copy.) 
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6 Technical Reference 

Server Board Jumpers 
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Figure 30.  Jumper Locations 

Table 10. Configuration Jumper 

Jumper Name Pins  What it does at system reset 

BMC WP A BMC boot block is write protected (normal operation).  If these pins are not 
jumpered, BMC boot block is erasable and programmable at next reset. 

CMOS CLR B If these pins are jumpered, the CMOS settings are cleared.  These pins should 
not be jumpered for normal operation. 

PSWD CLR C If these pins are jumpered, the CMOS password is cleared.  These pins 
should not be jumpered for normal operation. 

RCVRY BOOT D If these pins are jumpered, the system will attempt BIOS recovery.  These pins 
should not be jumpered for normal operation. 
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Diagnostic LEDs 
To help diagnose POST failures, a set of four bi-color diagnostic LEDs is located on the back edge 
of the baseboard.  Each of the four LEDs can have one of four states: Off, Green, Red, or Amber. 

The LED diagnostics feature consists of a hardware decoder and four dual color LEDs. During 
POST, the LEDs will display all normal Port80 codes representing the progress of the BIOS POST. 
Each postcode will be represented by a combination of colors from the 4 LEDs. The LEDs are in 
pairs of green and red. The post codes codes are broken into two nibbles, an upper and a lower 
nibble.  Each bit in the upper nibble is represented by a red LED and each bit in the lower nibble is 
represented by a green LED.  If both bits are set in the upper and lower nibble then both red and 
green LEDs are lit, resulting in an amber color.  Likewise, if both bits are clear then the red and 
green LEDs are off. 

During the POST process, each light sequence represents a specific Port-80 POST code.  If a 
system should hang during POST, the Diagnostic LEDs will present the last test executed before 
the hang. When reading the lights, the LEDs should be observed from the back of the system.  The 
most significant bit (MSB) is the first LED on the left, and the least significant bit (LSB) is the last 
LED on the right.  

Note: When comparing a diagnostic LED color string from the baseboard to those listed in the 
diagnostic LED decoder in the following tables, the LEDs on the baseboard should be referenced 
when viewed by looking into the system from the back.  Reading the LEDs from left to right, the Hi 
bit is located on the left. 

Table 11. Post Codes 
Diagnostic LED Decoder 
G=Green, R=Red, A=Amber 

Post 
Code 

MSB   LSB 

 
 

Description 

07h Off G G G Uncompress various BIOS Modules 

08h G Off Off Off Verify password Checksum 

08h G Off Off Off Verify CMOS Checksum. 

07h Off G G G Read Microcode updates from BIOS ROM.  

07h Off G G G Initializing the processors. Set up processor registers. Select least 
featured processor as the BSP. 

0Bh G Off G G Hook before the keyboard BAT command is issued. 

0Ch G G Off Off Keyboard Controller Test: The keyboard controller input buffer is 
free. Next, issuing the BAT command to the keyboard controller 

0Eh G G G Off 
Init after Keyboard Test: The keyboard controller BAT command 
result has been verified. Next, performing any necessary 
initialization after the keyboard controller BAT command test. 

0Fh G G G G 
Write Command Byte 8042: The initialization after the keyboard 
controller BAT command test is done. The keyboard command byte 
will be written next. 

10h Off Off Off R Keyboard Init: The keyboard controller command byte is written. 
Next, issuing the pin 23 and 24 blocking and unblocking commands 

10h Off Off Off R Disable and initialize 8259 

11h Off Off Off A Detect Configuration Mode, such as CMOS clear. 

13h Off Off G A Chipset Initialization before CMOS initialization 

continued 
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Table 11. Post Codes (continued) 
Diagnostic LED Decoder 
G=Green, R=Red, A=Amber 

Post 
Code 

MSB   LSB 

 
 

Description 

19h G Off Off A Init System Timer: The 8254 timer test is over. Starting the memory 
refresh test next. 

1Ah G Off G R Check Refresh Toggle: The memory refresh line is toggling. 
Checking the 15 second on/off time next 

23h Off Off A G 

Setup Interrupt Vectors: Reading the 8042 input port and disabling 
the MEGAKEY Green PC feature next. Making the BIOS code 
segment writable and performing any necessary configuration 
before initializing the interrupt vectors 

24h Off G R Off 
Before Vector: Configuration is required before interrupt vector 
initialization has completed. Interrupt vector initialization is about to 
begin 

25h Off G R G Init interrupt Vectors: Interrupt vector initialization is done.  

F2h R R A R Initialize SMM handler. Initialize USB emulation. 

F5h R A R A Validate NVRAM areas. Restore from backup if corrupted. 

12h Off Off G R Load defaults in CMOS RAM if bad checksum or CMOS clear 
jumper is detected. 

12h Off Off G R Initializing APP CMOS RAM for appliance servers only. 

12h Off Off G R Check point After CMOS Initialized 

27h Off G A G Validate date and time in RTC. 

F4h R A R R Load Micro Code To All CPUs 

F6h R A A R Scan SMBIOS GPNV areas  

15h Off G Off A 8254 Timer Test on Channel 2 

15h Off G Off A Enable 8042 

15h Off G Off A Keyboard Reset 

26h Off G A Off Initialize LCD, if supported. 

28h G Off R Off 
Set Video Mode: Initialization before setting the video mode is 
complete. Configuring the monochrome mode and color mode 
settings next. 

29h G Off R G Debugger Hook 

2Ah G Off A Off Init PCI devices and motherboard devices. Pass control to video 
BIOS. Start serial console redirection. 

2Bh G Off A G Platform hook 

2Dh G G R G Initialize AMI display manager Module. Initialize support code for 
headless system if no video controller is detected. 

2Dh G G R G Scan flash for logos and Initialize logo data areas 

30h Off Off R R Detect PS/2 Mouse 

30h Off Off R R Hook after c000 ROM control 

2Eh R R A Off Set up video parameters in BIOS data area. 

37h Off G A A Activate ADM: The display mode is set. Displaying the power-on 
message next. 

37h Off G A A Initialize language module. Display splash logo. 

37h Off G A A Display Sign on message, BIOS ID and processor information. 

38h G Off R R Detect USB Mouse: Initializing the bus input, and general devices 
next, if present. 

34h Off G R R Reset IDE Controllers 

continued 
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Table 11. Post Codes (continued) 
Diagnostic LED Decoder 
G=Green, R=Red, A=Amber 

Post 
Code 

MSB   LSB 

 
 

Description 

39h G Off R A Displaying bus initialization error messages. 

3Ah G Off A R Display Setup Message: The new cursor position has been read 
and saved. Displaying the Hit Setup message next. 

40h Off R Off Off Ensure Timer Keyboard Interrupts are on. 

4Bh G R G G 

Memory Test: The amount of memory above 8 MB has been found 
and verified. Checking for a soft reset and clearing the memory 
below 8 MB for the soft reset next. If this is a power-on situation, 
going to checkpoint 4Eh next. 

57h Off A G A Chipset hook after memory size  

53h Off R A A Display processor cache size. 

54h Off A Off R Disable parity and nmi reporting. 

60h Off R R Off Test 8237 DMA Controller: The DMA page register test passed. 
Performing the DMA Controller 1 base register test next 

65h Off A R G Init 8237 DMA Controller: The DMA controller 2 base register test 
passed. Programming DMA controllers 1 and 2 next. 

7Fh G A A A Extended NMI enable: Extended NMI source enabling is in 
progress. 

80h R Off Off Off 
Enable Mouse and Keyboard: The keyboard test has started. 
Clearing the output buffer and checking for stuck keys. Issuing the 
keyboard reset command next 

81h R Off Off G Keyboard Interface Test: A keyboard reset error or stuck key was 
found. Issuing the keyboard controller interface test command next. 

82h R Off G Off 
Check Stuck Key Enable Keyboard: The keyboard controller 
interface test completed. Writing the command byte and initializing 
the circular buffer next. 

83h R Off G G Disable parity NMI: The command byte was written and global data 
initialization has completed. Checking for a locked key next 

84h R G Off Off Verify RAM Size: Checking for a memory size mismatch with 
CMOS RAM data next 

84h R G Off Off Check ATA Cable Type presence of ATAPI devices 

84h R G Off Off Display Keyboard Message  

16h Off G G R Display IDE mass storage devices. 

17h Off G G A Display USB mass storage devices. 

85h R G Off G Report the first set of POST Errors To Error Manager. 

86h R G G Off Boot Password Check: The password was checked. Performing any 
required programming before Setup next. 

8Dh A G Off G OEM Patch 9 

8Dh A G Off G Set Printer RS-232 Timeout 

8Dh A G Off G Init FDD Devices: Resetting the hard disk controller next. 

95h R G Off A Lock out PS/2 keyboard/mouse if unattended start is enabled. 

92h R Off G R Option ROM Scan 

98h A Off Off R 
Init Boot Devices: The adapter ROM had control and has now 
returned control to BIOS POST. Performing any required 
processing after the option ROM returned control. 

continued 
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Table 11. Post Codes (continued) 
Diagnostic LED Decoder 
G=Green, R=Red, A=Amber 

Post 
Code 

MSB   LSB 

Description 

9Bh A Off G A Float Processor Initialize: Performing any required initialization 
before the coprocessor test next. 

9Eh A G G R Enable Interrupts 0,1,2: Checking the extended keyboard, keyboard 
ID, and NUM Lock key next. Issuing the keyboard ID command next 

A2h R Off A Off Report second set of POST errors To Error messager 

86h R G G Off Prepare And Run Setup: Error manager displays and logs POST 
errors. Waits for user input for certain errors. Execute setup. 

8Bh A Off G G Set Base Expansion Memory Size  

8Ch A G Off Off Adjust Setup: Programming the Setup options next. 

A5h R G R G Set Display Mode 

A7h R G A G OEM Patch 12 

A7h R G A G Build SMBIOS table and MP tables.  

A7h R G A G Program hotkey and timeout settings in keyboard controller. 

A7h R G A G Processor initialization before boot. 

A7h R G A G Copy required language strings to shadow RAM. 

AAh A Off A Off Clear video screen. 

000h Off Off Off Off One Beep to indicate end of POST. No beep if silent boot is 
enabled. 

000h Off Off Off Off POST completed. Passing control to INT 19h boot loader next. 
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7 Regulatory and Integration Information 

Product Regulatory Compliance 

Product Safety Compliance 

The SCB2 complies with the following safety requirements: 

• UL 1950 - CSA 950 (US/Canada) 
• EN 60 950 (European Union) 
• IEC60 950 (International) 
• CE – Low Voltage Directive (73/23/EEC) (European Union) 
• EMKO-TSE (74-SEC) 207/94 (Nordics) 
• GOST R 50377-92 (Russia) 

Product EMC Compliance  

The SCB2 has been has been tested and verified to comply with the following electromagnetic 
compatibility (EMC) regulations when installed in a compatible Intel® host system.  For 
information on compatible host system(s), contact your local Intel representative. 

• FCC (Class A Verification) – Radiated & Conducted Emissions (USA) 
• ICES-003 (Class A) – Radiated & Conducted Emissions (Canada) 
• CISPR 22 (Class A) – Radiated & Conducted Emissions (International)  
• EN55022 (Class A) – Radiated & Conducted Emissions (European Union) 
• EN55024 (Immunity) (European Union) 
• CE – EMC Directive (89/336/EEC) (European Union) 
• GOST R 29216-91 Radiated & Conducted Emissions (Russia) 
• GOST R 50628-95 Immunity (Russia) 
• VCCI (Class A) – Radiated & Conducted Emissions (Japan) 
• AS/NZS 3548 (Class A) – Radiated & Conducted Emissions (Australia / New Zealand) 
• RRL (Class A) Radiated & Conducted Emissions (Korea) 
• BSMI (Class A) Radiated & Conducted Emissions (Taiwan) 

Product Regulatory Compliance Markings 

This product is provided with the following Product Certification Markings. 

• cURus Recognition Mark 
• CE Mark 
• Russian GOST Mark 
• Australian C-Tick Mark 
• Taiwan BSMI Certification Number 3902I904 and BSMI EMC Warning  
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Electromagnetic Compatibility Notices 

Europe (CE Declaration of Conformity) 

This product has been tested in accordance too, and complies with the Low Voltage Directive 
(73/23/EEC) and EMC Directive (89/336/EEC).  The product has been marked with the CE Mark 
to illustrate its compliance.  

Australian Communications Authority (ACA) 
(C-Tick Declaration of Conformity) 

This product has been tested to AS/NZS 3548, and complies with ACA emission requirements. The 
product has been marked with the C-Tick Mark to illustrate its compliance.  

Ministry of Economic Development (New Zealand) Declaration of 
Conformity 

This product has been tested to AS/NZS 3548, and complies with New Zealand’s Ministry of 
Economic Development emission requirements. 

BSMI (Taiwan) 

The BSMI Certification number 3902I904 is silk screened on the component side of the server 
board; and the following BSMI EMC warning is located on solder side of the server board.  
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8 Equipment Log and Power Consumption 
Worksheets 

Equipment Log 
Use the blank equipment log provided here to record information about your system.  You will 
need some of this information when you run the SSU. 

 

 
Item 

Manufacturer Name and 
Model Number 

 
Serial Number 

 
Date Installed 

System 
 

   

Server Board 
 

   

Primary Processor Speed 
and Cache 

   

Secondary Processor Speed 
and Cache 

   

Video Display 
 

   

Keyboard 
 

   

Mouse 
 

   

Diskette Drive A 
 

   

Diskette Drive B 
 

   

Tape Drive 
 

   

CD-ROM Drive 
 

   

Hard Disk Drive 1 
 

   

Hard Disk Drive 2 
 

   

Hard Disk Drive 3 
 

   

Hard Disk Drive 4 
 

   

Hard Disk Drive 5 
 

   

continued 
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Equipment Log (continued) 

 
Item 

Manufacturer Name and 
Model Number 

 
Serial Number 

 
Date Installed 
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Current Usage 

✏  NOTE 

Both processors pull power from +12V.  This may limit the number of drives 
and/or add-in cards you may install. 

The average power usage should not exceed 15 watts per PCI slot. 

The cooling efficiency varies per slot; therefore, ensure that adequate cooling is available in the 
target slot—especially in an expansion slot dissipating more than 10 Watts. 

Calculating Power Consumption 

The total combined wattage for the system configuration must be less than the output of your power 
supply.  Use the two worksheets in this section to calculate the power used by your server boards.  
For current and voltage requirements of add-in boards and peripherals, see your vendor documents. 
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Worksheet, Calculating DC Power Usage 
 

1. List the current for each board and device in the appropriate voltage level column. 
2. Add the currents in each column.  Then go to the next worksheet. 

Table 12. Power Usage Worksheet 1 

 Current (maximum) at voltage level: 

Device +3.3 V +5 V 5 V Standby +12 V –12 V 

Server board 3.0 A 3.0 A .7 A 0.0  A 0.0 A 

Primary Processor       

Secondary Processor       

Memory (six DIMMs)      

Full-Height PCI riser slot (see note 1)      

     PCI slot 1      

     PCI slot 2      

     PCI slot 3      

Low-Profile PCI riser slot (see note 1)      

     PCI slot 1      

     PCI slot 2      

     PCI slot 3      

Server Board Current SUBTOTALS      

      

System Components (see note 2)      

      

      

      

      

      

      

      

      

Total Current      

Note 1:  Number of PCI cards depends on system and riser card configuration. 

Note 2:  List additional system devices and associated currents. 
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Worksheet, Total Combined Power Used by the System 
 

1. From the previous worksheet, enter the total current for each column. 
2. Multiply the voltage by the total current to get the total wattage for each voltage level. 
3. Add the total wattage for each voltage level to arrive at a total combined power usage on the 

power supply. 

Table 13. Power Usage Worksheet 2 

Voltage level and total current 
(V X A = W) 

Total Watts 
for each voltage level 

(+3.3 V) X (______ A) ________ W 

(+5 V) X (______ A) ________ W 

(–5 V) X (______ A) ________ W 

(+12 V) X (______ A) ________ W 

(–12 V) X (______ A) ________ W 

Total Combined Wattage ________ W 
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Index 

A 
Adapter Fault Tolerance, 13 
Adaptive Load Balancing, 13, 14 
administrative password, 17 

limiting access to SCU, 19 
AFT. See Adapter Fault Tolerance 
ALB. See Adaptive Load Balancing 
AMI, 93 

B 
battery 

disposing of safely, 39 
installing, 40 
removing, 39 

BIOS, 61, 92, 93, 94 
changing the language, 78 
recovering, 78 
update utility, 42 
upgrading, 77 

BIOS ID, 93 
BIOS Setup 

Boot Device Priority submenu, 52 
Boot menu, 52 
cannot enter, need to reconfigure 

diskette, 44 
changing configuration, 42 
Embedded Legacy SCSI submenu, 47 
Embedded NIC submenu, 47 
Embedded Video Controller submenu, 

47, 48 
Exit menu, 53 
Hard Drive submenu, 52 
how to enter during POST, 43 
Integrated Peripheral submenu, 48 
Main menu, 45 
Menu Navigation, 44 
Primary IDE Master and Slave 

submenu, 45 
Processor Settings submenu, 46 
recording settings, 44 
Removable Devices Selection submenu, 

52, 53 
Security menu, 49 
when to run, 43 

BIOS update, 77 
BMC LAN-Alert Dialog, 68 

Boot Device Priority submenu, configuring in 
BIOS Setup, 52 

Boot menu, configuring, BIOS Setup, 52 
boot sequence 

booting without keyboard, 19 
changing permanently, 54 
changing priority, 42 
changing temporarily, 53 
setting in Setup, 19 

booting cold, 83 
BSP, 92 
bus termination requirements, SCSI  

devices, 11 

C 
Caution 

avoid damaging jumpers when  
changing, 32 

avoid touching processor pins, 33 
selecting correct processor, 33 

Checksum, 92 
CMOS, 92, 93, 94 
configuration, limiting access to system with 

administrative password, 19 
Configuration, 92, 93 
Configuration Save/Restore Add-In, 65 
configuration utilities. See utilities 
configuring server board jumpers 

location on server board, 91 
configuring system 

BIOS Setup, 42 
System Setup Utility, 42 

controller, 92, 94 
keyboard/mouse, 14 
network, 7 
SCSI, 11 
video, 7, 11 

D 
diagnostics, preparing system for testing, 85 
Direct Platform Control, 56 

modes of operation, 57 
running, 57 

diskette 
enabling/disabling floppy writes, 18 
no booting in secure mode without 

password, 18 
running SSU from, 42 

DPC. See Direct Platform Control 
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E 
Embedded Legacy SCSI submenu, configuring 

in BIOS Setup, 47 
Embedded NIC submenu, configuring in BIOS 

Setup, 47 
Embedded Video Controller submenu, 

configuring in BIOS Setup, 47, 48 
Emergency Management Port 

Console, 42 
Emergency Management Port Dialog, 72 
equipment log, 99 
Error, 94, 95 
ESD 

add-in boards, 31 
avoiding damage to product, 31 
do not touch processor pins, 33 

Exit menu, configuring, BIOS Setup, 53 

F 
fan, heat sink, disconnecting, 34, 37, 38 
Fast EtherChannel, 13, 14 
FEC. See Fast EtherChannel 
Firmware Update Utility, 79 
form factor, 7 
Front Panel reset, 93 
FRU Manager Add-in, 63 
FRUSDR load utility, 42 
FRUSDR Load Utility, 79 

H 
Hard Drive submenu, configuring, BIOS 

Setup, 52 
heat sink, fan, 34, 37, 38 
hot key option, quick reference, 42 

I-K 
I/O 

PCI expansion slots, 7 
ports provided, 7 

Initialization, 92, 93 
Integrated Peripheral submenu, configuring in 

BIOS Setup, 48 
intrusion detection, 17 
jumpers, do not damage when changing, 32 
keyboard 

compatibility, 14 
lockout timer, seting in SCU, 14 

L 
LCD, 93 
lithium backup battery 

disposing of safely, 39 
installing, 40 
removing, 39 

M 
memory 

capacity, 7 
DIMM requirements, 10 
video amount, 7 
what type to install, 7 

Memory, 10, 94, 95 
Message, 94 
mouse 

compatibility, 14 
inactivity timer, 14 

MultiBoot Options Add-in, 60 

N 
network, controller, 7 
Network Teaming, 12 
NMI, 94 
NVRAM, 93 

P 
password, 17 

administrative, 17 
administrator, 17 
entering to unblank screen, 19 
user, 17 
using to reactivate keyboard/mouse, 19 
using to reactivate keyboard/mouse, 14 

Password, 94 
PCI 

embedded devices, 7 
expansion slots, 7 

PGA370, 10 
Platform Event Action Dialogs, 71 
Platform Event Manager Add-in, 66 
Platform Event Paging, 74 
Platform Event Paging Dialog, 67 
POST, 43, 94, 95 

viewing diagnostic messages, 43 
power supply 

calculating power usage, 101 
worksheet, calculating DC power, 102 

Power-on Self-Test, See POST, 94, 95 
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Primary IDE Master and Slave submenu, 
configuring in BIOS Setup, 45 

problems 
after running new application software, 84 
after system has been running correctly, 84 
application software, 90 
bootable CD-ROM not detected, 90 
cannot connect to network server, 88 
CD-ROM drive activity light, 88 
confirm OS loading, 85 
diskette drive light, 88 
initial system startup, 83 
network, 89 
no characters on screen, 86 
power light, 86 
preparing system for diagnostic testing, 85 
random error in data files, 84 
screen characters incorrect, 87 
system cooling fans do not rotate, 87 
system lights, 85 

processor, 33 
removing, 34, 38 
selecting the correct processor, 33 

Processor, 95 
Processor Settings submenu, configuring in 

BIOS Setup, 46 

R 
real time clock, running SCU to configure 

settings, 40 
Recovery Agent, 65 
remote system management. See Direct 

Platform Control 
Removable Devices Selection submenu, 

configuring in BIOS Setup, 52, 53 
removing termination board, 34, 38 
Reset, 93 
reset system, 83 
RTC, 93 

S 
SCSI 

bus termination requirements, 11 
SCSISelect utility, 54 

SCSI controller, 11 
SCU 

administrative password limits access 
to, 19 

inactivity (lockout) timer, 14 
software locking feature, 17 

SDR Manager Add-in, 64 

secure mode, 18 
affects boot sequence, 19 
enter by setting passwords, 18 
no booting from diskette without  

password, 18 
using hot keys to enter, 42 

security, 17, 18 
alarm switches, 17 
boot sequence, 19 
enabling/disabling floppy writes, 18 
locking mouse, keyboard with timer, 14, 19 
password, 19 
secure mode, 18 
secure mode, setting in SCU, 18 
software lock, SCU, 17 
unattended start, 19 
using hot key combination, 42 
video blanking, 19 

Security Add-in, 60 
Security menu, configuring in BIOS Setup, 49 
SEL, See System Event Log, 62 
SEL Manager Add-in, 62 
server board, configurations, 91 
server management, intrusion detection, 17 
Signal 

Data Terminal Ready, 15 
DCD, 15 
DSR, 15 
Received Data, 15 
Request to Send, 15 

SMBIOS, 93, 95 
SMM, 93 
soft boot, 83 
SSU. See System Setup Utility 
switches, alarm, 17 
Switches 

DC power, 83 
reset, 83 

System Event Log, 62 
System Setup Utility 

administrator password, setting, changing, 
clearing, 61 

changing configuration, 42 
Configuration Save/Restore Add-In, 65 
customizing, 59 
diskette drive required to run SSU, 42 
exiting, 74 
FRU Manager Add-in, 63 
launching a task, 60 
location, 57 
MultiBoot Options Add-in, 60 
Platform Event Manager Add-in, 66 
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BMC LAN-Alert Dialog, 68 
Emergency Management Port  

Dialog, 72 
Platform Event Action Dialogs, 71 
Platform Event Paging Dialog, 67 

running, locally, 58 
SDR Manager Add-in, 64 
Security Add-in, 60 
SEL Manager Add-in, 62 
System Update Add-In, 64 
user password, setting, changing,  

clearing, 60 
when to run instead of BIOS Setup, 44 

System Update Add-In, 64 

T 
termination board, removing, 34, 38 
Timeout, 94 
timer 

keyboard or mouse inactive, 14 
lockout (inactivity), setting in SCU, 14 

U 
USB, See also Universal Serial Bus, 93 
user password, 17 

limit access to using system, 19 
utilities 

BIOS Setup, 42, 43 
BIOS update, 42 
Emergency Management Port (EMP) 

Console, 42 
firmware update, 42 
Firmware update, 79 
FRUSDR load, 42 
FRUSDR load utility, 79 
SCSISelect, 54 
Setup. See BIOS Setup 
SSU, 42 

V-W 
video 

blanking for security, 19 
memory, 7 

video controller, 7, 22 
Warning 

components may be hot, 33 
dispose of lithium battery safely, 39 
ESD can damage product, 31 

worksheet, calculating DC power usage, 102 
write to diskette, disabling, 18 
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